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Copyright

Trademarks

FCC Compliance

Copyright © 2014 Stratasys Ltd. All rights reserved.

This documentation contains proprietary information of Stratasys Ltd. This information is supplied
solely to assist authorized users of Objet30 3D printing systems. No part of this document may be used
for other purposes, and it may not be disclosed to other parties.

The specifications on which this document is based are subject to change without notice.

No part of this book may be reproduced in any form or by any means, nor stored in a database or
retrieval system, without prior permission in writing from Stratasys Ltd.

If this document is distributed as a PDF file, you may print it for internal use.

The following are registered trademarks of Stratasys Ltd.: Stratasys®, Objet®, FullCure®.

The following are trademarks of Stratasys Ltd.: Objet30, Objet30-Pro, Objet30-OrthoDesk, Objet24,
Poly]Jet, Objet Studio, Job Manager.

Microsoft and Microsoft XP are trademarks of Microsoft Corporation.

All names of products and services cited in this book are trademarks or registered trademarks of their
respective companies.

The equipment referred to in this guide has been tested and found to comply with the limits for a
Class A device pursuant to part 15 of the FCC rules. These limits provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. Objet 3D
printing systems generate, use and can radiate radio-frequency energy and, if not installed and used
in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference, in which case
the user will be required to correct the interference at his own expense.

The 3D printer referred to in this guide contains a transmitter module, FCC ID YH6-RFID.

NOTE: Stratasys is not responsible for radio or TV interference caused by unauthorized modification
to this equipment. Such modification could void the user’s authority to operate the equipment.

Equipment Recycling

In the European Union, this symbol indicates that when the last user wishes to discard a product, it
must be sent to appropriate facilities for recovery and recycling. For information about proper
disposal, check your purchase contract, or contact the supplier of the equipment.

Limitation of Liability
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The product, software or services are being provided on an “as is” and “as available” basis. Except as
may be stated specifically in your contract, Stratasys Ltd. expressly disclaims all warranties of any
kind, whether express or implied, including, but not limited to, any implied warranties of
merchantability, fitness for a particular purpose and non-infringement.

You understand and agree that Stratasys Ltd. shall not be liable for any direct, indirect, incidental,
special, consequential or exemplary damages, including but not limited to, damages for loss of profits,
goodwill, use, data or other intangible losses (even if Stratasys has been advised of the possibility of
such damages), resulting from: (i) the use or the inability to use the product or software; (ii) the cost of
procurement of substitute goods and services resulting from any products, goods, data, software,
information or services purchased; (iii) unauthorized access to or alteration of your products, software
or data; (iv) statements or conduct of any third party; (v) any other matter relating to the product,
software, or services.

The text and drawings herein are for illustration and reference only. The specifications on which they
are based are subject to change. Stratasys Ltd. may, at any time and without notice, make changes to
this document. Stratasys Ltd., for itself and on behalf of its subsidiaries, assumes no liability for
technical or editorial errors or omissions made herein, and shall not be liable for incidental,
consequential, indirect, or special damages, including, without limitation, loss of use, loss or alteration
of data, delays, or lost profits or savings arising from the use of this document.
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About This Guide

Using This Guide

This user guide provides instructions for installing, operating and
maintaining Objet 3D printing systems. It explains how to use features, and
provides practical examples to guide you as you use the system.

This document is meant to be used with Objet30 3D printers, running
software version 33.2.0, and with Objet Studio software version 9.2.

This guide assumes that:

® all the hardware, software, and network components of your Objet
system are installed, configured, and operating correctly.

® the operator has a working knowledge of the Windows® PC platform.

For More Information

1-2

Visit http://www.stratasys.com/ for more details about Objet printer
technology, products and consumables, and for service and support
contacts.

For other documents that relate to Objet30 3D printing systems, and for this
document in other languages, contact your regional Stratasys Customer
Support office.

If you have any questions about the information presented in this
document, or if you have any comments or suggestions for future editions,
please send a message to c-support@stratasys.com.

DOC-34015 Rev. B


http://www.2objet.com/ 

Objet30 User Guide

Terms Used in This Guide

build tray

cleaning fluid

client/user workstation

Objet™ printer

Printer computer

Printer interface

Printer software

host/server workstation

Job Manager™

Model material

Objet Studio™

OBJTF (Objet Tray Format)

OBJZF (Objet Z Format)

resin

DOC-34015 Rev. B

In Objet Studio: The surface displayed on the screen that
represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing material feed tubes and the printing
block, used to completely remove Model and Support
material from the system before loading another type of
material in the printer and before long-term shutdown. The
cleaning fluid is supplied in standard material cartridges.

The workstation on which Objet software is installed, used
for preparing build trays for production on Objet printers.
(There is no limit to the number of client workstations in the
local network.)

The Objet 3D printer referred to in this guide.

The computer inside the Objet printer that operates it. (This is
sometimes referred to as the “embedded” computer.)

The GUI (graphical user interface) used for controlling the
Objet printer.

Software running on the computer inside the Objet printer,
that controls all printer operations.

The workstation that interfaces directly with the Objet printer
and is typically positioned next to it.

The part of Objet Studio software that manages production
jobs before they are sent to the Objet printer.

Material used for building models.

The software with which users prepare jobs for producing
models.

The extension of a file that contains all of the information
needed for a model-printing job on Objet 3D printers. An objtf
file is used to send a print job to an Objet 3D printer.

The extension of a compressed “wrapper” file containing all
of the files used in an Objet Studio build tray. Using objzf files,
a printing job can be saved as a single file, for convenient
storage and transfer.

The base substance from which photopolymer printing
materials are made for use in Objet printers. In Objet Studio
and printer-application screens, “resin” refers to cartridges of
model and support materials.
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SLC A file type used with Objet software. (These files are bitmaps
of individual slices of the object. For more information, see
page 3-4.)

STL A file type used with Objet software. (For more information,
see page 3-4.)

Support material Material used for supporting the structure of models during
production.

1-4 DOC-34015 Rev. B
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Safety Features

Objet 3D printers are designed to comply with CE and FCC standards.
They are equipped with the following safety features:

Cover Interlock The power supplied to the UV lamp and the
Switch motion motors is turned off when the cover is
opened.

WARNING: Do not defeat (override) the
& interlock switch. Doing so could result in
serious personal injury. If the interlock switch
does not function correctly, do not use the
printer, and contact your service provider.

Safety Lock The cover is locked while the printer is
working. The lock is released when the printer
reverts to pause or stop mode.

WARNING: Do not defeat (override) the
& safety lock. Doing so could result in serious

personal injury.

If the safety lock does not function correctly, do

not use the printer, and contact your service

provider.

UV Screening The transparent section of the cover blocks
harmful UV radiation, allowing the operator to
view the model as it is being made.

Circuit Breaker The power to the printer is turned off in case of
electrical overcurrent.
Note: The circuit breaker is only accessible to
service personnel.

Grounded Chassis The chassis of the printer is grounded, to
prevent electrical shock.

Note: The power outlet must be properly
grounded, in accordance with the local
electric code, to provide this protection.

UV screen

Cover interlock switch

Circuit breaker

Figure 2-1: Front and back views of the Objet30 printer

If the Objet 3D printing system is not used as specified in this guide, the
safety features may not provide adequate protection.

DOC-34015 Rev. B 2-3



Safety

Symbols and Warning Labels

This following table lists the warning labels located on or in Objet printers.

printer.

Warning Meaning Location Comments

Symbol
Hazard On the name plate | Read the instructions
(general) on the back of the | in this document

before operating the
printer.

Hot surface

On the print-head
block.

Risk of burns. Do not
touch this surface
after printing.

High voltage | Near the UV lamp | Risk of electric shock.
connector.
Near the power-
supply enclosures.
Ultraviolet Near the UV lamp. | Risk of injury from
radiation ultraviolet radiation.
Moving parts | On top of the Risk of injury from

printing assembly.

moving parts.

DOC-34015 Rev. B
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Safety Guidelines

Printer
Installation

Printer
Operation

UV Radiation

Printer
Maintenance

3
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The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the Objet system. If the system is not operated as specified,
the user's safety may be compromised!

» Installation and removal of the printer should only be done by qualified
service personnel.

» Connect the printer to the electric outlet using a power cord that is
safety-certified.

A\

The electric outlet should be easily accessible, near the printer.

» Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose
the operator to serious danger from electric shock.

O FI: Laite on liitettdva suojakoskettimilla varustettuun pistorasiaan.
O NO: Apparatet ma tilkoples jordet stikkontakt.
O SE: Apparaten skall anslutas till jordat uttag.

» Leave a minimum of 20 centimeters between ventilation openings and
walls or other objects.

» The printer should only be operated by persons trained by a Stratasys
customer-support representative.

» All personnel operating or maintaining the printer should know the
location of first aid and emergency equipment and how to use it. Never
block access to this equipment!

A\

Keep fingers and other body parts clear of the printer cover when
closing it.

Never attempt to open the main cover of the printer while it is working!
Never override the interlock safety switch!

If the interlock safety switch ever fails, do not use the printer.

YV V V V

Several parts of the printer remain extremely hot even after it has
stopped operating. Avoid touching the UV lamp and the print block.
The UV lamp used in the printer emits dangerous radiation.

> If the UV lamp remains on when the printer cover is open, do not stare
directly at the UV light. Shut down the printer and call your Stratasys
service provider.

» Service operations should be performed only by qualified personnel
who have been instructed in relevant safety precautions.

» Notify co-workers and those who have access to the Objet system
before beginning non-routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

2-5
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Model and
Support
Materials

2—6

Model and support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all
model and support materials used by the Objet system are handled in
sealed cartridges. Normally, operators of the printer should never be
directly exposed to hazardous materials. In the unlikely event of a leak or
spill, follow the instructions that are included with the printing-material
cartridge used.

» Store model and support materials indoors, in a dry area with adequate
ventilation, between 16-27 degrees Celsius (60-81 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.

» Keep model and support materials away from areas where food and
drink are stored, prepared and consumed.

» Uncured printing material is considered a hazardous substance,
requiring certain precautions when directly handling it. To prevent skin
irritation, wear neoprene or nitrile gloves. If there is any chance that
model and support materials might splash into the eyes, wear safety
goggles. Prolonged direct contact with printing materials can cause an
allergic reaction.

» When handling UV-cured models that may not be completely cured on
the surface, common latex gloves are adequate.

» To prevent respiratory irritation, ventilate areas where model and
support materials are used. The ventilation system should totally
replace the air at least four times per hour.

» Clean up model-material and support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl
alcohol (IPA), followed by soap and water. Dispose of the absorbent
material in accordance with local regulations.

» Do not wash contaminated clothing at home; clothing should be
professionally laundered.

» Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing
material may re-expose the user when these items are worn.

DOC-34015 Rev. B
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First Aid for Working with Printing Materials

3

Contact with
Skin

Contact with
Eyes

Ingestion

Inhalation

DOC-34015 Rev. B

In general, try to avoid direct contact with uncured printing material. If
skin or eyes come into contact with it, wash the area immediately and
thoroughly with water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing
materials contains important safety information. Keep this in an accessible
place where these materials are used and stored.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

» Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

» Do not use solvents to clean skin.

> If large areas of skin have been exposed, or if prolonged contact results
in blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

» Avoid the accidental transfer of printing material from the hands to
other areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

> Avoid sunlight, fluorescent light, and other sources of ultraviolet
radiation.

The wearing of contact lenses when handling liquid printing materials is
not recommended. If the liquid splashes into the eyes when contact lenses
are worn, immediately remove the lenses and flush the eyes with water.

» Clean and disinfect the contaminated lenses.
» Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Vapors from printing materials can be irritating to the respiratory system.
If respiratory irritation occurs, expose the victim to fresh air immediately.

» If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

Seek medical attention immediately.
Keep the patient warm but not hot.

Never feed anything by mouth to an unconscious person.

vV V V V

Oxygen should be administered by authorized personnel only.
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Waste Disposal

Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste.

2-8

>

>

>

A\

When removing the waste container from the Objet printer, wear
neoprene or nitrile gloves.

To prevent liquid waste from splashing into the eyes, wear safety
goggles.

Liquid waste from the Objet printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and
disposed of in a manner that prevents human contact with it and
contamination of water sources.

Empty model-material and support-material cartridges contain residue
of their contents. Some leakage of this residue may occur through the
broken cartridge seal. Therefore, handle and store empty cartridges
with care.

Do not attempt to reuse empty cartridges, and do not puncture them.

Dispose of used cartridges and waste containers in accordance with
local regulations.

Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.

DOC-34015 Rev. B
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@urer

Figure 3-1: The Objet30 3D Printer

Work Configurations

The Objet 3D printing system can be set up as a single-station system or as
a multi-station system. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user
workstation (client) prepares files with Objet Studio software for
production. A server (host), typically next to the 3D printer, acts as a job
manager that sends production jobs to the printer for production.

Figure 3-2 shows the Objet30 printer set up in a multi-client configuration.
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Client workstations

Y Printer
workstation

Printer server

| I
Objet printer H

Figure 3-2: Multi-client network configuration

When installing Objet Studio, you choose whether to install it as a client
station or as a master station (server or standalone station).

Objet Studio arranges the jobs it receives according to their priorities,
model-material type, and other factors. In multi-workstation
configurations, the operator of the server—typically the production
administrator —has total control over the jobs sent to the 3D printer, and
can prioritize and delete jobs, review job history and reprint a job, and so
on.

DOC-34015 Rev. B 3-3



Introducing the Objet 3D Printing System

Source Files

STL Files

SLC Files

Objet 3D printing systems produce three-dimensional models designed
with most 3D CAD tools and with other job-specific 3D applications. Objet
systems accept:

e STL Files
e SLC Files

Objet systems feature the capability of producing different types of model
files simultaneously.

STL is short for Standard Triangulation Language. This language views any
object as a collection of surfaces, and describes each surface of the object as
a collection of triangles.

For example, a square can be described as two triangles; a cube (six
squares) as 12 triangles. Curved surfaces need more triangles to describe
them. The higher the tolerance (for smooth surfaces), the more triangles are
needed. The result is that high-quality object descriptions mean very heavy
files.

Most CAD software can export STL files. The Objet system utilizes these
files for building models (rapid prototyping), and also for directly making
molds for mass-producing items.

STL files can be ASCII (text) files or binary files. The content of the ASCII
tile begins with “solid” and ends with “end-solid” (both lower case).
Between these keywords is a list of the triangles that describes the faces of
the solid model. Each triangle defines a single normal vector directed away
from the solid’s surface, followed by its X-Y-Z coordinates. These are
expressed as Cartesian coordinates and are floating-point values. The
coordinates of all triangles should be positive and should fall within the
volume of the model.

SLC is short for Stereo-Lithography Contour. SLC files describe two-
dimensional contours of the three-dimensional models. These contour lines
are polylines.

SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in
Objet Studio may be different than the solid-object images displayed from
STL files.
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Printing Materials

Available
Materials
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Objet printers produce models by jetting thin layers of printing materials
on the build tray, until the complete model is formed. Two types of material
are used in this process:

* Model material —which makes up the finished model
* Support material —which fills gaps and spaces in the model during
printing, and is removed after printing

Different types of Model materials are available for Objet30-series printers,
depending on the printer model.

Vero | VeroClear| Durus | Hi-temp | Endur MED610
RGD810 | RGD430 | RGD525| RGD450| MED690
Printer Model MED620
Objet30 Pro v v v v v
Objet30 v v
Objet30 OrthoDesk v
e Vero

Materials in this group are suitable for general model making, and come
in a choice of color (white, blue, gray, black and VeroClear™).

All of these materials offer the following features:
O thermo-plastics simulation (appearance and feel)

O high dimensional stability (especially with VeroGray™,
VeroWhitePlus™, VeroBlackPlus™ and VeroClear)

3O excellent detail and surface quality
e VeroClear™

VeroClear RGD810 is a transparent material simulating PMMA. Its
characteristics are the same as other Vero materials.

* Durus
DurusWhite RGD430™ features:
O polypropylene simulation (appearance and feel)

3 enhanced toughness and flexibility —suitable for reusable containers
and other snap-fit applications

* High Temperature RGD525
High Temperature RGD525™ is an off-white material, which features:

O excellent heat resistance (up to 80° C) —parts retain their shape, even
in extreme conditions

O high durability
O fine surface finish
O long shelf life

3-5
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* Endur RGD450
Endur RGD450™ is a white material, which features:
3O polypropylene simulation (appearance and feel)
O enhanced toughness
O high dimensional stability
O excellent detail and surface quality

* MED

Materials with Vero-material properties, formulated for medical and
dental applications.

O MED610™ —clear, bio-compatible
O VeroGlaze MED620™ —white
3 VeroDentPlus MED690™ —opaque, peach color

For up-to-date information about PolyJet printing materials and their
properties, go to http://www.stratasys.com/materials/polyjet.
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Materials used for printing models with Objet printers are made of resins,
which are composed of reactive monomers and oligomers. Although
printing materials are supplied in sealed, UV-proof cartridges, care must be
taken when storing and handling them. Follow these guidelines to protect
operators and the environment, and to ensure optimum results.

* To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances
(such as polystyrene or polyvinyl chloride) are not suitable for storing
PolyJet printing materials.

*  When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

* Store material cartridges indoors, in a dry area with adequate
ventilation, between 16-27 degrees Celsius (60-81 degrees Fahrenheit).
If exposed to heat or flames, cartridges may burst or ignite.

* Signs of premature polymerization in material cartridges may include
bulging, leaking, the emission of heat, and unusual odor. Exposure to
heat can cause resin to gel in the cartridge.

* Make sure that material cartridges are stored in accordance with all
local regulations and other applicable requirements.

Materials used for producing models have a limited shelf life. The expiry
date on the label is valid when properly stored in an undamaged,
unopened cartridge. Always rotate your stock, so that the cartridge with
the earliest date is used first.

If printing materials are not in their sealed cartridges, make sure to shield
them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.

Before being cured, resins are hazardous materials. To prevent possible
health hazards, follow these precautions regarding printing materials:
* Do not expose to flames, heat or sparks.

* Prevent contact with skin and eyes.

* Ventilate areas where they are handled.

* Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

You can find more safety information about resins in “Safety Guidelines” on
page 2-5, and “First Aid for Working with Printing Materials” on page 2-7.

Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.
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Work Environment

Extreme heat and humidity conditions can adversely affect the operation of
the Objet 3D printer. Therefore, it is recommended that you use ventilation
or air-conditioning systems, if necessary, to keep the work area within the
following ranges:

* 18°-25° C (64°-77°F)
* 30%-70% relative humidity
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Workstation Requirements

The table below lists the requirements for computer components on
workstations running Objet Studio.

Important: Make sure that the server workstation is set up with
Administrator privileges.

Requirement

Computer Type

Server workstation: Standard desktop PC!

Processor

Intel® Core™ i3 or better

Operating System

Windows® 7 or Windows® 8, 64-hit?

RAM

8 GB or more?

Open GL®

Graphics Card3 Memory: 1 GB; 2 GB recommended for dental applications

For server workstation: VGA connector®
CD/DVD ROM

Optical Drive
Hard-Disk Drive

80 GB or larger (minimum free space: 40 GB)

LAN TCP/IP
(2 for server workstation; 1 for client workstation)

Network Card

Mouse/Keyboard

. Server workstation: USB?
Connection

Monitor Cable VGA connector!

1. For systems using a KVM switchbox to control both the
built-in printer computer and the server workstation with
same keyboard-monitor-mouse set: All-in-one computer,
wireless mouse and wireless keyboard cannot be used.

2. A 64-bit operating system is recommended, to utilize 8 GB
of memory. Objet Studio running on a 32-bit application
can utilize only 4 GB of memory.

3. The following %raphics cards were tested in Stratasys labs:
e NVIDIA® Quadro” Family —FX570, FX1700
¢ NVIDIA® GeForce® Family —6200 TurboCache™, 7300 GT, GTX 285
» Intel® Express Chipset—82915G/GV, 82910GL, Q965, Q963, Q35, Q45, Q43,

82852, 82855

¢ ATI Radeon™ HD 5670, HD 5970
¢ AMD Radeon™ E6760

4. For systems using a KVM switchbox. If the server
workstation has a DVI video connector, a VGA adapter is

needed.
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Preparing Files for Use with Objet 3D Printing Systems

Converting
CAD Files to
STL Format

Converting
CAD Files to
SLC Format

3-10

Before using files with Objet 3D printing systems, you need to convert them
in your CAD program to a file format supported by Objet Studio. (For an
explanation of these file formats, see “Source Files” on page 3-4.)

You can print several models or parts at the same time, after arranging
them on the build tray in Objet Studio. The following are the maximum
dimensions for a single model printed on the Objet30 printer:

* With glossy finish—
X-axis: 294.00 mm (11.57 inches)
Y-axis: 192.00 mm (7.55 inches)
Z-axis: 148.60 mm (5.85 inches)*
* OrthoDesk printers —100.0 mm (3.94 inches)
e With matte finish—
X-axis: 293.00 mm (11.53 inches)
Y-axis: 191.00 mm (7.52 inches)
Z-axis: 148.30 mm (5.83 inches)*
* OrthoDesk printers —97.9 mm (3.85 inches)

This procedure may vary slightly, depending on the CAD software used,
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.

2. Inthe Save As dialog box, open the Save As Type pull-down menu and
select *.STL.

3. Click Options and set the following parameters:

* Total Quality —approximately 0.01 mm (deviation tolerance /
linear-dimension tolerance)

* Detail Quality —approximately 5° (angle tolerance)

Note: Lowering these values produces more accurate models, but
results in larger files and longer loading and processing times. For this
reason, it is generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and
ASCII formats can be used in Objet Studio. However, binary files are
smaller, so this option is recommended.)

5. Click OK or Save.

After converting the model files, it is recommended that you check them for
defects in an STL-repair application (such as Magics™, by Materialise®)
before opening them in Objet Studio and producing the model.

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before
being saved as SLC files. Considerations for suitable model orientation are
explained in “Model Orientation” on page 5-20.
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Objet Studio Software

3
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Objet Studio software for the Objet 3D printing system consists of two main
screens:

* Tray Settings / Model Settings
* Job Manager

Tray Settings / Model Settings

In the Tray Settings and Model Settings screens, you prepare source files for
production in Objet 3D printers. Objet Studio offers you a wide variety of
tile-preparation options, but always consists of the following basic
procedure:

Inserting one or more objects on the build tray
Positioning the object(s) on the tray

Configuring object and tray parameters

L

Saving the tray configuration as an objtf (Objet Tray Format) file
5. Sending the objtf file to the Objet 3D printer for production

Using Objet Studio to perform these tasks is described in detail in chapter 5,
“Using Objet Studio.”

Job Manager

The Job Manager screen is different for client workstations and for the
computer connected directly to the Objet 3D printer.

* In Objet Studio installed on the directly-connected computer (server),
the Job Manager screen displays the queue and status for all jobs sent to
the 3D printer by the server itself and by all client computers on the
network. All jobs displayed can be edited and manipulated.

* In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3D printer server
from that computer. Only these jobs can be edited and manipulated
from the client computer.

Client computers can be connected, via the local network, to different Objet
3D printers, but only to one at a time. The Job Manager screen displays the
status of the 3D printer to which the client is currently connected.
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How to Install Software for the Objet 3D Printing System
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How to Install Software for the Objet 3D Printing System

The Objet Studio setup wizard guides you when installing this software.
Objet Studio is installed on the printer-server (“host”) computer, but it can
also be installed on remote, “client” computers and on computers used to
prepare files for printing models, or for training and demonstration
purposes. During installation, you choose to install either the printer-server

(“host”) application or the client application.

To install Objet software:

1.
2.

Insert the Objet Studio CD into the disk drive.

Right-click the Start button and select Explore (or use any other method
for displaying files on the computer).

Open the CD-drive folder and select Setup.

If you are installing an Objet Studio upgrade, make sure that your
printer is compatible with it by checking the list displayed.

0Objet Studio Setup

B Please note...

! This version of Objet Studio is *not™ compatible with the following

versions of the printer software:

- Connex500, 57.0 (and below)
- Connex 350, 37.0 (and below)
- Eden500V, 50.2 (and below)
- Eden350V, 36.0 (and below)
- Eden260V, 27.0 (and below)
- Eden350 (all versions)

- Eden330 (all versions)

- Eden2a0 (all versions)

- Eden250 (all versions)

- Alaris30 (all versions)

If the printer software is incompatible, printing will not be possible
after this Objet Studio installation.
For more information, contact your Objet service provider.

To install Objet Studio, dick OK.

oK I Cancel

Figure 4-1:0bjet Studio compatibility check

5. To install Objet Studio, you must agree to the license agreement. After

reading its terms, click Yes to continue, or No to close the wizard.
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If you click Yes, the following screen should appear.

i Objet Studio 9

Welcome to the Objet Studio 9 Setup Wizard

The inztaller will guide you through the steps required to install Objet Studio 9 on your
computer,

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

[ Cancel ] [ < Back ] [ Mewt > l

Figure 4-2: Objet Studio installation wizard—Welcome screen

6. Click Next to begin installation.
In the Select Features screen, select the required installation option.
Select Objet Studio for a server computer...

® if you are installing Objet Studio on the server (“host”) computer —
the computer directly connected to an Objet printer.

® if you are installing Objet Studio on a standalone (off-line)
computer.

Select Objet Studio for client workstations if you are installing Objet
Studio on a “client” workstation —a remote computer that prepares
print jobs and then sends them to a server computer.

i Objet Studio

Select Features

Select the prefered Objet Studio Installation twpe for your computer

(%) Obiet Studio for a server computer.

() Obiet Studio for client workstations.

[ Cancel ] [ < Back ] [ Mewt >

Figure 4-3: Objet Studio configuration selection
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8. In the Select Installation Folder screen, verify the destination folder and
click Next.

It is recommended that you do not change the default destination folder.

Click Disk Space to check the space in the destination folder.

i Objet Studio 9

Select Installation Folder

The inztaller will install Objet Studio to the following folder.

Ta inztall in this folder, click "Mext. Toinstall to a different folder. enter it below or click “Browse.

Folder:

C:\Program FilestObjetStudio’ Browse...

Inztall Objet Studio for yourself, or for anyone who uses this computer.

Figure 4-4: Objet Studio installation-folder selection

9. In the Confirm Installation screen, click Next to begin installation.

10. In the Select Printer Type screen, select the Objet 3D printer used for
producing models.

To continue, click Next.

Select Printer Type

Select an Objet Printer.
() Objet24 () Objet260 Connex
() Objet30

() Objet30 Pro

() Objet30 Scholar

() Objet30 OrthoDesk

(C) Objet 1000

< Back Mext >

Figure 4-5: Printer selection

Note: For Alaris30U printers, select Objet30.
For Alaris30 Pro printers, select Objet30Pro.
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Installation begins and a progress bar appears, showing the progress of
the installation process.

i Objet Studio 9

Installing Objet Studio

Obijet Studio 9 iz being installed.

Flease wait...

Cancel

Figure 4-6: Installation progress bar

When the Objet program installation is complete, the final InstallShield
Wizard screen appears.

i Objet Studio 9

Installation Complete

Obijet Studio 9haz been successfully installed.

Click "Close" to exit.

Cloze

Figure 4-7: Final installation screen

11. Restart the computer to complete the software installation.

Note: If you installed the software from a CD or DVD, make sure to remove
it from the disk drive before restarting the computer.

The installation process ends when the appropriate icon(s) appear on the
computer desktop:

¢ Objet Studio

® Stop Job Manager (for servers and standalone stations)
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How to Uninstall Objet Studio

If there is ever a need to uninstall the Objet Studio software, do not attempt
to do so from the Windows Control Panel. (This does not completely
remove all software components.) Instead —

» From the Start menu, select All Programs > Objet Studio > Uninstall Objet
Studio.
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Launching Objet Studio

After you install Objet Studio, a launch icon |oe: studo

Windows® 7
Security
Warning

DOC-34015 Rev. B

appears on the

Windows desktop. Open the application by double-clicking this icon, or by

selecting Objet Studio from the Start menu.

Depending on the User Account Control settings in Windows® 7, you may
see the following warning when opening Objet Studio.

r -
Hy) User Account Control ﬁ

O Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  ObStudio.exe
Publisher: Unknown
File origin: Hard drive on this computer

Change when these notifications appear

%

Figure 5-1: Security Warning

If you click Yes, Objet Studio opens. However, this warning message will
appear each time you open the program, unless you change the User

Account Control settings.

To prevent the warning message from appearing again:
1. Click the link at the bottom of the security warning dialog box (Change

when these notifications appear).

2. Inthe User Account Control Settings screen, move the slider to “Never

Ly
notify.
%) User Account Control Settings O | B |
Choose when to be notified about changes to your computer
User Account Contral helps prevent potentially harmful programs from making changes to your computer.
Tell me more about User Account Control settings
Always notify
-] - Notify me only when programs try to make changes to
my computer (do not dim my desktop)
*  Don't notify me when I make changes to Windows
- - seftings
-
@ Mot recommended. Choose this only if it takes a long
[ time to dim the desktop on your computer.
Never notify
B oK Cancel

Figure 5-2: Changing the User Account Control settings

3. Click OK.
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Objet Studio

Interface

5-4

4. In the following dialog box, click Yes.
r '@ User Account Control M

Do you want to allow the following program to make

“changes to this computer?

|ﬁ;‘| Program name:  UserAccountControlSettings
¥ Verified publisher: Microsoft Windows

'Zi’::' Show details Yes ] [ iy J

Change when these notifications appear

Figure 5-3: Confirming the change in the User Account Control settings

When Objet Studio opens, the Tray Settings screen appears, showing an

empty build tray.
Objet LBy S — Help
Studio %
Commands | = Standard
menu o Toolbar
_ Active
Quick ribbon
Access
toolbar
Job
Manager
tab
Model tree
pane

Figure 5-4: Objet Studio opening screen

The Objet Studio interface consists of two main screens:
* Tray Settings—for arranging models and preparing them for printing.
* Job Manager—for monitoring and managing print jobs.
This screen is described in “Monitoring and Managing Print Jobs” on
page 57.
Each screen is controlled by menus and icons on its own ribbon. An

additional ribbon, Model Settings, displays controls for configuring and
manipulating selected models.

Objet Studio anticipates your workflow by displaying and enabling the
options relevant to your current task. For example, when you first open
Objet Studio, the Model Settings ribbon is disabled until you place a model
on the build tray. Similarly, menu options available from the Standard
Toolbar menus are enabled or disabled to match the current workflow.
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Tray Settings

t

Insert | b

Made|
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The ribbon, colors used, and several other interface features can be
customized. How to change the appearance of the interface is explained in

“Customizing Objet Studio” on page 46.

Instructions for using the commands for preparing models for production
and sending jobs to the printer, appear later in this chapter.

Objet Studio
Job Manager

¢ge LN O Q W

Plane MNew Open Save  Undo Redo Single Zoom Tsometric

By
Material =

s

= X

Edlt - View + Object - Tools ~ Styls + @) *

Vi~ Tige FullCure720 -

BLild Process Selection File Edit View Colors Currently Ioaded: FulCure?20 Estimatss are nok available.

O % - Objetstu... Wrench Key oEX
=4 Tray Settings Model Settings Job Manager Edit - Yiew ~ Object - Jook - Style ~ @) -
s Cut o IV N i 7 % 15590 " Uniform Scale| | mm <
vor % ) P e e B O W ‘ hiny (@l = | &
“3COPY  Delete Undo Redo | Plane || Move Transform Lock Single Zoom Isometric || Vi 9968 Pilimeter | [Matte | Glossy Advanced By

e o - o M - terial -
Edit Selection Manipulate View Dimensions (mm) Urits Options Colors

Figure 5-6: Model Settings ribbon
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Ribbon The following table lists the Tray Settings and Model Settings ribbon
Commands command groups, and shows when they are enabled, and where they
appear.
Group Purpose When Tray Model
enabled Settings  Settings
Ribbon  Ribbon
Setting display | Always.
g%% colors.
: J | v
Material =
Colars
ﬂ OL Selecting Models are on
ti d | the build tray.
Single: Zoom Egésrﬁelgéée an € bulid fray d d
Wigy = Tray =
Yiew
| Choose to select | Models are on
Plat:e a plane. the build tray. d d
Selection

i

a
‘a@

=

a=zmh

Change the
perspective of
the active pane.

Models are on
the build tray.

HQ V| HS L . ;
T = Assigning model Bmld tray
i 1s empty.
material. p d
* Models are
not
selected.
v Undoing or After an
e redoing actions. | action or d d
Undo Redo .
obI]ect
= selection.
Edit
veroiithite: 4.0 Estimating the | Build tray is
Ep— - amount o not empty. d
A printing
Building Time: 01:25 .
o , materials
Estimated Consurnptions required.
Opening and Models are

o g8

Mew Open Save

File

saving tiles.

not selected.
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5

files on the build

J

Group Purpose When Tray Model
enabled Settings Settings
Ribbon  Ribbon
Placing model | Always.

Insert tray.
Madel
» R = r&( Pre-build/build | Models are on
¥ ¥ 9 5 commands. the build tray. d
Placement Validabe Estimate Build
" pinbiationnsoaly Setting model | A model is
1416 dimensions. selected. d
2101
Dimensions {rmm)
4 Cut %_\ e Cutting, A model is
Py COMY  Delete Undo Reds copymig, pasting | selected. d
e e = - and deleting
= models.
Edit
T @ 41 Moving, rotating | A model is
= b B and resizing selected. d
Move Transform  Lock models.
Manipulate
DD Assigningmodel | A model is
4 finish an selected. d
atte |Glossy Advanced N
setting support
strength/
Gptions “hollow.”
g Setting amodel’s | A model is
T unit of measure | selected. d
o (millimeters or
. inches).
Lnits

3
3
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To quickly identify an icon, move the cursor over it to display a tooltip. The
“Undo” and “Redo” tooltips change to reflect your last Objet Studio action.

After activating some of the ribbon commands (by clicking them), they remain
active until you click another button or until you press the Escape key.
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Objet Studio
Commands
Menu

Model Tree
Pane

5-8

Clicking the Q icon in the upper-left corner opens the Objet Studio
Commands menu. This menu displays basic application commands and
options.

Ve LA EESL

\?3/' Hew Recent trays
> 1 testiengn
é‘ Qpen,..
2 Trayad
é Save

3 Ci\Program Filesy.. \Trayss

é Save As...
n@ Save Bitmap. .. Ctr+B

?g@. Impart Packed Job,..

@ Export Packed Job. ..

.@;‘ Build Properties. ..

4 C:\Program Filesy.. .| Trayl

djz| User Preferences. .

ri Printer Properties...

Restart

Figure 5-7: Objet Studio Commands menu

The Options button opens a dialog box for customizing Objet Studio.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement

Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]

O Mever
(@) Ahways
(O \When under the tray

Large Filez
() Load Ful
(O Load Partial (reduced)

Load Search Order
O Local
(&) Driginal

[ Ok H Cancel ]

Figure 5-8: Options dialog box

The Model Tree pane lists the objects placed on the build tray. By default,
the pane “floats” — that is, you can move it to another position on the
screen and resize it. Alternatively, you can fix its position at the left of the
application window, and even hide it.
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Preparing Models for Production

OBJDF Files:
Overview

Model Files

Placing
Objects on the
Build Tray
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Model preparation involves the following basic steps:

1. Place objects on the build tray.

2. If necessary, manipulate the object’s orientation and position.

3. Select the material and model finish.

An objdf file describes both the geometry of a single object and the material,
and finish required to print it. You can use this file format to save a group

of separate objects on the build tray as one unit, together with their relative
positions and material.

Further explanations of objdf files, and their features, appear throughout
this chapter.

To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
two ways:

* by inserting individual st! or slc files.
* Dby pasting objects that you copied to the Windows clipboard.

If you know what type of model material will be used to produce the
models, make sure it is selected from the material drop-down menu.

—
Curusiihite -

[ ] Durushhite
. YeroBlack
|:| YeroBlue

|:| Werorey
[ ] verowhite

Figure 5-9: Model material selection toolbar

Note: Itis not necessary to select the Model material now, but it is
recommended—each type of material has unique characteristics
that may affect the valid positioning of objects on the build tray. The
material selected can also affect printing time—printing with Objet
VeroClear takes longer than printing with other materials.

To place an object on the build tray:

Open the Insert dialog box—

* From the Object menu, select Insert.
or—

* On the Tray Settings ribbon, click nsert .
or—

* Right-click on the build tray, and select Insert from the context
menu.
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5-10

The Insert dialog box appears.

Documents

Desklop

_JSTL Fles
i Text30
L Trayl
My Documents
)
wd
Iy Compuber
- File name: sample file bt
My Metwork  Files of bppe: STL Fiies [“.5t) v | Cancel
Units: Militater bt
Number of Copiez: |1 > D [#] Diert Automaticale

Lock in: | (=3 Samples vl QX E
5 (JBasi Shapes
L) (Do
iy Recent JConnex Samples

) Connex_Samples
JIEden_alaris_Samples
Cilmages

I5LE Files

Coordnales
Width (] Depth(Y] Hexght )
Etents 229 5o2ae 229

[¥] Prenview

Figure 5-10: Insert dialog box

In the Look in field, display the appropriate folder.

In the Files of type field, select the file type to display.

Select the desired file, and make sure that it appears in the File name

field.

If the Preview check box is selected, the object is displayed in the dialog
box, as shown in figure 5-10.

The Model Settings ribbon is displayed when objects are placed on the
build tray.

Note:

Select any of the following options, as required:

Units —Millimeters or inches for the object’s units of measure.

The 3D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters
or inches when inserting an object. Otherwise, the size of the object
on the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see “Measurement Units” on page 24.

Number of copies —How many copies of this object to place on the
build tray.

Orient Automatically — Automatically orient objects on the build
tray for efficient model building.

The Extents values displayed in the Coordinates section of the Insert
dialog box, represent the maximum dimensions of the object on each
axis. These dimensions correspond to the virtual “bounding box”
surrounding the object see figure 5-36 on page 30).
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6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

'@_‘bbét B Poket Cond okt Objet Studia -
] B - Yew v Qhject < Tesk o Sl v R -

P o o B T . E*m@'.a«x B & | &
By

DS  Deetn ndo [k | Pbne | Hove Tramfom ook |7 lersy Advarced W Zeom
= ;m Wews  Taye || Hetwise

Seloction Maripulste Cmensions (mm)

Model
Toolbar

_ M 1 ) 3050 T 5,57 _Hodelsi | L

Figure 5-11: Default screen layout

The Model Settings ribbon is displayed when objects are placed on the

build tray.

If the object is over a certain size, the Loading Placed Elements dialog box
may appear.

Loading Placed Elements |g|

todel Mame IE:H...'\GHender'\B inhTray] obitf

I ]

Placed Elerment IE:'\...'\testI:uuiId.u:uI:uidf

I ]

T Ef}R}R}TE
Figure 5-12: Loading Placed Elements dialog box

You can speed up the opening of large files by changing the Large Files
settings—see “Loading Large Files” on page 34).
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Opening objdf files

Before placing objdf files on the build tray, Objet Studio must extract the

component stl files together with information about their relative position
and model materials. To do this, Objet Studio creates a folder with the same
name as the objdf file, in the same location.

Look in: | I Samples

@.

My Recent
Documents

=

Desklop

2>

My Documents

My Computer

by Metwork,

|C5)Basic Shapes
() chess

|C5) Connesx Samples
|C5) Connes_Samples
[C)Eden_alaris_Samples
@Images
I5)sample File
[C)5LC Files

[C3)5TL Files

(5 TextaD
@Trayl

ray |

File name: |Tray1

v

[ Inzert ]

Filez of type: | Obijet Digital Files [* objdf]

]

[ Cancel ]

Urits:

Millitd eter v

Mumber of Copies : |1 e

Coordinates
Width (] Depth [v)  Height [£)
Extents

I aterials

[] Orient Automaticaly

Packed Azzembly File
Wercwhite

Preview

Figure 5-13: Insert dialog box (objdf file)
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Opening Objet
Tray Files

S
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You can open trays that were saved as objtf files. This is useful, for example,
if you saved a tray after preparing it for printing, and now you want to
make changes before printing it.

To place an object saved as an Objet Tray File (objtf) file on the build

tray:

1. From the File group, click open.

or—

From the Objet Studio Commands, select Open.

The Open dialog box is displayed.

Bk
Look in' [ 3 Basic Shapes v o2 @
y e
) G
My Recent
Documents
€
Deskiop
My Documents
—
-]
5l
My Computer
‘_‘] File rame: Tray1
2
My Network  Files of type Obiet Tray Files (%.obitf) -
Coordinates
[#] Pravisw

Figure 5-14: Objet Tray File Open dialog box

2. Select the desired file, and make sure that it appears in the File name

field.

If the Preview check box is selected, the object is displayed.

3. Click Open.

Objet Studio opens the tray file.

The obijtf file is actually a file containing instructions for printing—which stl
files to print and their position on the build tray. Because the obijtf file
references the stl files used, they must remain in the same file location as

when the objtf file was saved.
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STL file loading  If there are identically named st! files in more than one location, you need
preference to ensure that the correct component st/ files are linked to the objtf file. For
example, if there are identically named st/ files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you

can set the default location from which files are loaded.

To set the Load Order:
1. From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.
2. In the Options dialog box, display the Settings tab.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement

Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]
O Mever

(@) Ahways
(O \When under the tray

Large Filez

() Load Ful
(O Load Partial [feducad

oad Search Order
O Local
(&) Driginal

[ Ok H Cancel ]

Figure 5-15: Options dialog box, Settings tab

3. Under Load Search Order, select an option:
* Local—to load files from the location where they were last saved.
* Original —to load files in their original location.

4. Click OK.
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Quick-Access You can access common commands for working with objects on the build
Model tray with the convenient Model Toolbar and context menus.
Commands

Model Toolbar Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

Figure 5-16: Model Toolbar
The table below describes the Model Toolbar icons.

Icon Description
'J Applies a matte finish to the model.

B Applies a glossy finish to the model.
o

- Opens the Advanced Properties dialog box for setting the
‘ﬁ{ Grid Style and the Hollow option.

-::E;‘ Enables dragging an object (see page 5-25).

-

o Opens the Transform dialog box for changing the

:I’; object’s position and scale.

= Toggles the Lock Model Orientation setting.

Right-click model If you right-click on an object, a pop-up context menu is displayed from
menu  which you can also select the model finish, change its position and scale,
and set the Grid Style and Hollow options.

You can also create a Quick Access toolbar with your most commonly used
icons grouped together. See “Creating a Quick Access Toolbar” on page 46.
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Copying and
Pasting
Objects

5-16

If you need to duplicate objects on the build tray, you can insert the same
object from its file more than once. An easier way, however, is to copy and
paste the object. You can copy objects from the build tray or the model tree.
The objects copied remain in the Windows clipboard until you paste them
onto the build tray.

You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another
one. However, Objet Studio allows only one tray to be open at a time. For
each build tray you need to work with (at the same time), you must open a
separate Objet Studio window, by running the application again (from the
Windows Start menu).

Having multiple Objet Studio windows open can be convenient when you
need to manipulate or configure objects before inserting them in your
production build tray. Copying and pasting also allows you to use objects
already configured on previously-used build trays for newer projects.

You perform the Copy and Paste commands as in other Windows
applications:

* from the right-click context menu.
* by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).

The Paste Special command (from the object’s right-click context menu)
enables you to place duplicate objects even more efficiently:

* You can specify the number of duplicates to place on the build tray at
once.

* You can set the distance, on each axis, between the duplicate objects.

* You can manipulate mirror images of the original object, and flip them
on selected axes.

X]

Paste Special

Mumber of Copies E
Delta
= 100 Y 100 Z |0 rirm
M anipulate
Mirrar [ I [N =
Flip [ ES 1y [z
[ ]5ave as Defaults [ ] l [ Cancel

Figure 5-17: Paste Special dialog box
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Selecting
Objects

Surface Finish
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To manipulate an object on the build tray or assign characteristics to it
(building style, for example), you must first select the object. You select an
object by clicking it, either on the tray or in the model tree. Its image on the
build tray changes color (to light blue, by default) and its name is
highlighted in the model tree. You can select multiple objects by drawing a
box around them with the mouse cursor, or by pressing the Ctrl or Shift
keys while clicking additional objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

* Select All
* |nvert Selection
* Undo Select object

Edit = Wjew + Ohject -

4 undo Select object

Select All
Invert Selection
Figure 5-18: Edit menu
Models can be printed with a matte or glossy surface finish. To create a

matte finish, the printer surrounds models with a thin layer of support
material.

To set the model finish:

1. Select the model.

2. Select Matte @ or Glossy @ in one of the following places:
*  Model Settings ribbon, Options group
* Model Toolbar
* right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects” surface
finish on the build tray by color. To configure how Objet Studio displays
objects, see “Setting Object Colors” on page 33.
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Positioning Objects on the Build Tray

To produce models efficiently and with the required finish, it is important
to carefully position objects on the build tray. Objet Studio supports the
automatic positioning of objects. However, you should check to make sure
that the objects are orientated logically for your needs, according to the
considerations explained in “Model Orientation” on page 5-20.

Automatic
Orientation

5-18

W=

Two things that affect the positioning of objects on the build tray are
orientation and placement. You can let Objet Studio determine the optimum

orientation and position, or you can control them.

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the
orientation manually.) However, you can cancel automatic orientation
when placing an object on the build tray.

To place an object on the build tray without automatic orientation:

> In the Insert dialog box, make sure Orient Automatically is not selected.

Look ir:

A
16)
My Recent
Documents

Desktop

My Documents

w8
My Compiter
<

-
My Network

2 x|
3 Samples ¥ O3 =
(9Basic Shapes
(iChess
) Connex Samples
() Connex_Samples
Eden_laris_samples
Chlmeges
Ssample file
L)5LC Files
IE3)STL Files
2 Textad
S)Trayt
B Trayt
File nare Tiayl v Insert
Files of type: Obiet Digital Files (*.obid) v
Uit [ Milibster v

Nurber of Copies : |1 2 €O orient Automaticaly

Coordinates

Width <] Depth[v) Height [2) -
Extents
Materials - i
Facked fssembly File ;

Werdvw/hite
Preview

Figure 5-19: Orient Automatically option disabled

You can change the default setting, so that automatic orientation is not
applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see “Default Settings” on

page 52.
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Automatic
Placement

A

Manual
Positioning
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After placing several objects on the build tray, you can let Objet Studio
arrange them on the tray for printing. This ensures that the objects are
positioned properly, and that they will be printed in the shortest time and
with a minimum of material.

To automatically arrange objects on the build tray:

» On the Tray Settings ribbon, click Placement .
or—
From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-21: Tray arrangement after applying Automatic Placement

* For best results arrange the tray with Automatic Placement, on the Tray
Settings ribbon, even if you inserted the objects with the Orient
Automatically option.

* The physical characteristics of each type of Model material you use can
affect the positioning of objects on the build tray. Therefore, select
materials before running Automatic Placement.

You can change the position of objects on the build tray —even if they were
inserted with the Orient Automatically option. Considerations for
positioning objects are presented in “Model Orientation,” below. Tools for
changing the position of objects are presented in “Manipulating Objects on
the Build Tray” on page 5-21.
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Model Orientation

5-20

The orientation of models on the build tray affects how quickly and
efficiently they will be produced by the 3D printer, where and how much
support material is used, and whether or not model parts will have a glossy
finish. Therefore, you should consider a variety of factors when deciding
how to place models on the tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

> Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along
the Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

» Any surfaces that come into contact with support materials become
matte.

» Since models are built up, on the Z-axis, in 30-micron layers, it is very
time-consuming to print a tall object. From this point of view, it is
advisable to place the object's smallest dimension along the Z-axis.

» Since the print heads measure about 2 inches (5 centimeters) on the
Y-axis, models measuring less than this (on the Y-axis) are printed in
one pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

» Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the tray, the print heads only have to scan the
model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

The following rules are based on the fact that support material is not
required on the top of the printed model.

Recess-Up Rule

This rule considers models containing surface recesses.

» Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.

Fine-Surface Rule

This rule considers models that have one side on which there are fine
details (like the keypad side of a telephone).

» The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.
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Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at
least one side (like a pipe or a container).

» It may be advantageous to print a model standing up, so support
material does not fill the hollow, even though printing the model lying
down would be much faster.

Manipulating Objects on the Build Tray

Positioning
Objects on the

Z-Axis

DOC-34015 Rev. B

When you use the automatic positioning option to arrange objects on the
build tray (see “Automatic Orientation” on page 5-18), the objects are
positioned directly on the tray. If you do not insert objects with automatic
positioning, they often appear either above or below the tray.

In practice, the Objet system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects
on the screen.

To position objects directly on the tray:

1. Select the object.
2. From the Object menu, select Lay On.

To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement

Guick Automatic Placement after adding new object

Prezerve 1

mm  distance between objects

Automatic Lay On [Gravity)
O Mever

(@) Ahways
() \When under the tray

Large Filez

() Load Ful
(O Load Partial (reduced)

Load Search Order
O Local
(&) Driginal

H Cancel ]

[ ok

Figure 5-22: Options dialog box, Settings tab
2. Inthe Automatic Lay On (Gravity) section, select Always.
Other Z-axis options (in the Automatic Lay On section):

* When under the tray —The display of objects that are below the build
tray is automatically changed so that the object is at tray level.

* Never—The display of objects that are above or below the build tray is
not changed.
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Valid Object You can ensure that models do not overlap when you position them on the
Placement build tray, and that they do not extend beyond the tray.

To ensure valid object placement:

1. From the Tools menu, select Constraints Settings.

| a‘
Constraints
Colars
Default Color
Outzide Tray
Callision

Bath

iin

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-23: Constraints Settings dialog box

2. Select Dynamic check to identify:
* invalid object placement while placing objects —On Drop selected.
* invalid object placement after moving objects —While Drag selected.
* objects placed beyond the tray’s boundaries —Outside Tray selected.
* objects that overlap—Object Collision selected.

tray, Objet Studio automatically checks if there is a problem with the
positioning of objects on the tray before sending it to the printer. You can
also manually check for problems after positioning objects (see “Tray
Validation” on page 37).

Q Even if you do not use Dynamic Check when placing objects on the build

Note: Remember that Objet Studio calculates the space occupied by an
object including the “bounding box” surrounding it (see figure 5-36
on page 30).
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Usinga Grid to Displaying a grid on the image of the build tray can be useful when

Position positioning objects. To use the grid features, select the following menu
Objects options.

Menu Option Result

Tools > Grid Displays a grid on the build tray.

Tools > Snap to grid | When moving the object, it aligns with the nearest

grid line.
Tools > Options > Enables you to change the grid origin
Grid (X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them —from the
Options dialog box.

To view and change grid settings:
1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Options §|

Appearance | Grd Manipulate | Display | Settings
[ Display arid
[15napto grid
Colors

Tile zize 20 | mm

= Base -
Maiar divisi 10 = i

ajor division v | tiles Bt -

Mumber of tiles |32 E

= Majar -
Line style Dot
Uritz Millitd eter v
Oigin [0 3o 2o < |mm

u].9 Cancel

Figure 5-24: Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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Measurement 3D files contain an object's proportions, but not its units of measure.

Units Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.

To set the measurement units when inserting an object:
» In the Insert dialog box, Units field, select Millimeter or Inch:

Insert

Look, in: |L'f)SampIes v| Q ¥ m-
Y |L5)Basic Shapes
4 :3 () chess

My Recent I Connesx Samples
Documents |23 Connes:_Samples
— [C)Eden_alaris_Samples

F
|— @Images
Desktop | |)sample file
[C5LC Files
; [C5TL Files
"_/' [ Text3D
My Documents DiTrayt )
@ sample file
My Computer
_ File name: | A | [ Insert ]

My Metwark, Files of type:

Cancel

Figure 5-25: Units field in the Insert dialog box

To change measurement units for a selected object from the
Model Settings ribbon:

1. Open the Units flyout toolbar.

mm
=

Millimeter

-

@ its

nch
-

Figure 5-26: Units flyout toolbar
2. Select the measurement units desired.

To change measurement units for a selected object from the Standard
Toolbar:

1. From the Object menu, select Change Units.

killitd eter
Ihich

Figure 5-27: Model Units dialog box
2. In the Model Units dialog box, change the setting and click OK.
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Setting Model
Dimensions

Repositioning
Objects
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You can change an object’s dimensions by changing its size on the X-, Y-,
and Z-axes, from the Dimensions group on the Model Settings ribbon.

¥ 360 % Unifarm Scale

i 416
£ 101

| Cirnensions () |

Figure 5-28: Dimensions on the Model Settings ribbon

* If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.

* After changing a measurement, press Enter or click in another field in
the Dimensions group.

Note: You can change the height of the objects on the build tray only if this
is allowed by the Objet Studio settings (see “Positioning Objects on
the Z-Axis” on page 5-21).

You can manually move and rotate an object on the build tray with the

arrow keys, or by dragging it with the mouse.

To manually manipulate an object:

1. Select an object by clicking it on the build tray, or in the model tree
pane.

2. Click wave on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

Figure 5-29: Manually moving an object
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3. Ifyou click on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

Figure 5-30: Manually rotating an object
4. Manipulate the object with the arrow keys or with the mouse.

Using the Transform  You can make precise changes to an object by changing the properties in the
Dialog Box  Transform dialog box.

To access the Transform dialog box (when an object is selected):
* Click ﬁ; on the Model Toolbar or on the Model Settings ribbon.
* From the right-click context menu, select Transform.

* From the Object menu, select Transform.

Transform rz|

idth(x) Depth(t] Height(Z)

. -
Translate.| 0 v|

-

u;|

|
Fotate: | [ | [
|

Scale: |‘I e 1 :|

Cancel Actions

Figure 5-31: Transform dialog box

To change an object with the Transform dialog box:

» Change any of the values, then click Apply to see how the object
changes on the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see
how the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:
» Click Reset.
Note: The object does not change. Any changes previously applied remain.
To undo all changes made with the Transform dialog box:
» Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.
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Changing an
Object’s
Orientation
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There are several methods for changing the orientation of objects on the
build tray.

To rotate an object:

> Select the object and use the Object menu options (see also

To re-align an object’s plane: +*
1.

“Repositioning Objects” on page 5-25).
Flne
On the Tray Settings or Model Settings ribbon, click e .
or—
From the Tools menu, select Plane Alignment > Select Plane.
Click on part of an object on the build tray.

The selected plane is displayed.

Alignment
toolbar

Selected
plane

Figure 5-32: Aligning by plane

On the Alignment toolbar, click an appropriate icon to change the
alignment.

or—

From the Tools menu, select Plane Alignment, and select an alignment
option.

| Plane Alignmenk k -E Select Plane
Professional Mode L'{' Align Battom
TirmeMaterial Estimation "} S iz
assembly Map ... i Align Front
%0 Align Back
LEEN=EfEn: S Align Left
Lptions. . o align Right

Figure 5-33: Tools menu, Plane Alignment options
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Freezing Model
Orientation

5-28

To cancel plane selection after re-aligning objects on the build tray:

.z-li_.J
Flane
» On the Tray Settings or Model Settings ribbon, click e -
or—
From the Tools menu, select Plane Alignment > Select Plane.
To flip an object 180 degrees on any axis:
1. Select the object.

2. From the Object menu, select Flip > Flip X/ Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:

1. Select the object.

2. Display the Transform dialog box (see figure 5-31 on page 26).

3. Change the Rotate parameters for each axis.

If you manipulate an object on the build tray, you can freeze its orientation

so that it does not change when you position it automatically (see
“Automatic Placement” on page 5-19).

To freeze an object:
1. Select an object on the build tray.

2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click & .

To unfreeze an object:
> Select the object and click & (to de-select it).
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Display Options

Viewing From the View menu, you can change the way objects are displayed. The
Objects default method for displaying models on the build tray is as solid
(“shaded”) objects.

Figure 5-34: Tray and model displayed in Shaded view

The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

» From the View menu, select WireFrame.

==

Figure 5-35: Tray and model displayed in WireFrame view

To revert to the shaded view:

» From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions
instead of their shape:

» From the View menu, select Display Bounding Box.

-:-:.:_

Figure 5-36: Model displayed with bounding box

To display the area around objects needed for support material (to
produce a matte finish):

» From the View menu, select Display Thickening Box.

Figure 5-37: Model displayed with thickening box

To display the maximum build height:
» From the View menu, select Display Tray 3D Box.

Figure 5-38: Tray 3D Box

To display objects without the build tray:
» From the View menu, clear (de-select) the Display Tray option.
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Screen Layout
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Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.

To change the screen layout:
> On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-39: Screen layout icons

O Single View |[[/| is the default screen layout.
3 4 Views displays perspective, top, front and right views.

__| Assembly_Sample_Shell

Figure 5-40: Single-view screen layout

. paripecthe

Figure 5-41: 4-view screen layout
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Tray The default perspective of the build tray is “isometric.” You can change the
Perspective perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:
1. On the Tray Settings ribbon, open the Perspective flyout toolbar.

Isometric

Figure 5-42: Perspective flyout toolbar

2. Click the icon that represents the desired perspective.

Tray Positioning To view the tray and models from different directions, you can move the
tray around the screen and change its display angle.

To move the tray in the Objet Studio screen:

» Press the mouse wheel while moving the mouse.

Figure 5-43: Tray after moving it in the Objet Studio display

25 T e T e—n e
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To manually rotate the tray:

> Press Alt and press the mouse wheel while moving the mouse.

9
> \
o

BP0 62 EmL Mol | M

Figure 5-44: Tray after rotating it upside-down

Setting Object  The color of objects on the build tray can indicate how they are printed.
Colors Objet Studio enables you to choose the color display so that you can easily
see the material, and surface of objects.

To choose how colors are applied on the display:

» On the Model Settings ribbon, in the Colors group, select one of the
options from the flyout toolbar.

®

ik Color indicates Model material

Material -
@ﬁ/ Color indicates Model surface
EELPLE

==

®

=

Figure 5-45: Colors display options

validation, Objet Studio checks if there is a problem with the stl files or the
positioning of objects on the tray. If so, the affected objects are displayed
with special colors (see “Tray Validation” on page 5-37).

Q Before sending a build tray to the printer, or when you perform tray
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Loading Large
Files

Large File
Manipulation

5-34

Very large stl files can be slow to load and may be difficult to manipulate
easily on the build tray. If this is the case, you can display just an image of
the object on the build tray without loading the entire file. The st! file itself
is not changed, and the complete file is sent to the printer.

To display an image of stl files when you place objects on the build tray:

1.

2.

From the Tools menu, select Options, and display the Settings tab.

Options x

| tppearance | Grid | Manipulate | Display | Settings |

Automatic Flacement

Quick Automatic Placement after adding new object

Preserve mm  distance between objects

Automatic Lay On [Gravity)
O Never
(@) Abways
OWhen

Large Files

O Load Full
(&) Load Partial (reduced]

Laoad Search Order
© Local
& Original

Apply

Figure 5-46: Options dialog box, Settings tab

In the Large Files section, select Load Partial (reduced).

If you need to work with a detailed model that is composed of a large
number of polygons, you can speed up its display and manipulation in
Objet Studio by reducing the number of polygons on the screen. Although
this may reduce the resolution on the screen, it has no affect on the printed
models.

Figure 5-47: Object displayed without polygon reduction

Figure 5-48: Object displayed with only five percent of its polygons showing
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To use polygon reduction:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands Menu, click Options.
2. In the Options dialog box, display the Display tab.
Options X

Appearance | Grid Manipulate | Display | Settings
[[] Enable Polygon Reduction

Display while changing wiew
(%) Bounding Box

() Entire Object

Diigplay when static view

) Bounding Box
(®) Entire Object

Save Polygon Reduction Data

Figure 5-49: Options dialog box, Display tab

Select Enable Polygon Reduction.

Select Polygon Reduction (Percent).

Enter the percentage of total polygons to display.
When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being
moved).

6. Set display options when the object is being moved (Display while
changing view):

* Bounding Box— A box representing the object’s maximum
dimensions is displayed.

* Adaptive Polygon Reduction —Varying degrees of polygon reduction
are applied, as necessary.

* Entire Object—No polygon reduction is applied.

7. To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

8. Click Apply to see the results of the settings without closing the dialog
box.

% Selecting the Entire Object option cancels polygon reduction.
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Object display The display format affects how quickly objects display. For example, if you
options select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).

To select the object display preference while changing view, and in static
view:
1. Select to display objects:
* With a Bounding Box (see figure 5-36 on page 30)
*  With Adaptive Polygon Reduction (changing view only)
*  With Polygon Reduction (static view only)
* Entire Object
2. Click OK when done.

Zoom Options  While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

» On the ribbon, open the Zoom flyout toolbar and select an option:

Zoom by Rectangle

Figure 5-50: Zoom flyout toolbar
O Zoom Object focuses on the selected object.
O Zoom Tray displays the whole tray.

O Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See “Automatic Zoom” on page 52.
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Handling Completed Trays

After you have properly placed all objects on the build tray, you save the
tray as an objtf file, which is sent to the 3D printer for production. But before
saving the tray, you can check that there would be no problem producing it.
You can also calculate how much material would be consumed during
production and how much time this would take.

Tray Validation Before sending a job to the printer for production, you should check that
the tray is “valid” and can be printed.

To validate that the tray can be printed: Y
» On the Tray Settings ribbon, in the Build Process group, click valdate .
or—
From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

| @1
Constraints
Colars
Default Color
Outzide Tray
Callision

Bath

iin

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-51: Color code

Note: The “Both” color also indicates a problematic stl file.

The validation status appears on the bar at the bottom of the screen.

Yalidation succeeded Maodels: 1

Figure 5-52: Validation details in status bar
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Production
Estimates

E-mailing
Objet Digital
Files
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Objet Studio enables you to calculate the time and material resources
needed for producing trays before sending them to the printer. The time it
takes Objet Studio to perform this calculation depends on the number of
objects on the tray and their complexity. Calculating the production
estimate for a full tray could take up to 15 minutes, depending on your
computer’s specifications.

To calculate the time and materials needed for producing the current
tray: &

» On the Tray Settings ribbon, in the Build Process group, click estimate .

While the estimate is being calculated, a progress bar is displayed —on
the right side of the status bar (at the bottom of the screen).

I

I ks ____Cancel

Figure 5-53: Estimate progress bar

When Objet Studio finishes calculating the production resources, the
results are displayed in the Estimated Consumptions group on the Tray
Settings ribbon.

Yerohhite: 35.0
Suppork: 27,0
Building Time:  00:23
Estimated Consumptions
Figure 5-54: Production resource calculation
You can easily e-mail objdf files using Microsoft® Office Outlook®. Sending
objdf files is recommended (instead of st files) because the size of a file is

typically reduced by more than half. An added benefit is that the objdf file
contains the model-material information for the object.

To e-mail a file:
1. From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the
e-mail form.

2. Enter the e-mail address and send the file.
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Printing the When a tray is ready to be printed, it is placed in the Jobs Queue. When the
Tray File job reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the 3D printer.
To send the tray to the print queue: <
1. On the Tray Settings ribbon, Build Process group, click guid.

If the build tray file has not been saved, the Save As dialog box opens for
you to save it now.

Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors
(see “Tray Validation” on page 37), and a warning message appears.

Warning

Overlapping objects!
- Click Mo to separate objects manually
or with Automatic Placemert.

-- Click Yes to print the tray a3 is.

Do you want to proceed anpwap?

Figure 5-55: Tray validation warning message

O To cancel the Build command so you can correct the problem, click
No.

O To print the models as they are positioned on the tray, click Yes.

The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See “Monitoring and
Managing Print Jobs” on page 57.
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Applying Additional Objet Studio Features

Dividing
Objects

5-40

You can use the Split Object feature to produce objects larger than the tray
area by dividing the model into separate parts. With this feature, you
produce only a specific section of a model.

To split an object:

1.
2.
3.

Select the object.
From the Object menu, select Split.

In the Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its
axes, by entering either exact measurements or the number of parts.

| Model Tree |
© Tray1 I
__| Applications - FLUTE_Shell3_Part1 |
_| Applications - FLUTE_Shell3_Partz

Objest Size 35 226 22588
©spitbyses (M7 |[37 |22 | [ petout
Ostipmter [ ||

Figure 5-56: Split Object dialog box
In Save to Folder, enter the folder name.
Click OK.

The composite parts are saved as new st! files with “Part 1,” “Part 2,”
etc., added to the original file name.

Note: Before printing the newly created stl files, it is recommended that you

check them for defects in an STL-repair application, such as
Magics™, by Materialise®.
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Choosing the
Support
Strength
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When producing models, support material fills some hollow and empty
sections (see “Model Orientation” on page 5-20). Objet Studio allows you to
adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate
support strength.

To change the strength of the support structure used when printing a
model:

1.
2.

Select a model on the tray.

On the Model Settings ribbon, in the Options group, click %.

or—

¢  On the Model Toolbar, click .

or—

* From the right-click context menu, select Advanced Properties.

The Advanced Properties dialog box opens.

Advanced Properties ﬁ

Grid Style [ ] Hallaws
{*) Standard

) Heawy
(7 Lite

Apply

Figure 5-57: Advanced Properties dialog box

In the Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each
model on the tray.

* Standard —for models needing average support (most models).
* Heavy —for large models needing much support.

* Lite—for delicate models needing little support. (This setting makes
it easy to remove the support material.)

Click Apply.
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“Hollow”— Many objects placed on the tray from st/ files are “solid.” This means that,

Filling Models ~ when printed, the model will be completely filled with model material.

with Support Often, especially with large objects, this is unnecessary. Instead, the model

Material can be filled with support material, which is less costly. It is also advisable
to fill models with support material when preparing them for investment
casting, since this material burns off more quickly during the process of
making the cast.

Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. When using this
feature, called “Hollow,” the thickness of the shell should be no less than
0.5 millimeters.

To use the Hollow feature:
1. Select a model on the tray.
or—
¢  On the Model Toolbar, click o
or—
* From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.
2. Select Hollow.

Advanced Properties

Grid Style Hollow

(%) Standard

O Heawy Shell Thickness: |1.35
O Lite

Apply

Figure 5-58: Advanced Properties dialog box

3. Set the shell thickness, in millimeters.

4. Click Apply.

Note: There is no change in the display of objects in Objet Studio when
Hollow is selected.

To inspect, change or cancel the Hollow setting:

1. Select a model on the tray.

2. Access the Advanced Properties dialog box, as above.

3. If you change or cancel the Hollow setting, click Apply.
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Displaying the  The Section feature enables you to view the interior of an object by “slicing”

Cross Section it on any axis. You can then manipulate the object to inspect the interior

of Objects from different angles. This may be important for deciding on the type of
support necessary when producing the model (see “Choosing the Support
Strength” on page 5-41). Displaying an object’s cross section only affects
how the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

The Section dialog box opens.

Section |X|

Section |

#

-

z

¥ Enable Clipping

Figure 5-59: Section dialog box

Select Enable Clipping.

3. Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that
you see the cross section you want.

Figure 5-60: Whole view Figure 5-61: Cross-section view, after
using the Z-slider
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Saving the
Screen Display
as an

Image File
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You can save the image displayed in the active viewing screen as a graphic

file.

To save the screen display as an image:

1.

ISR

Press Ctrl+B.

or—

From the Objet Studio Commands Menu menu, select Save Bitmap.

The Save Bitmap dialog box opens.

Save Bitmap

RIX

Savein |2 STL Files

=] « ® ok E-

(20026

(20148

*Apnllcatlons - Tab Coating.bmp
*Traya.bmp

[0 To Last Folder Yisited]

File: name: ‘Applications - Tab Coating

Save as twper | Bitmap [ brp]

Cancel

DataType: [RGB True Color  (24-hit)

Compression: ‘Nnn-CDmplessed

Figure 5-62: Save Bitmap dialog box

At the top of the dialog box, select the appropriate folder.

At the bottom of the dialog box, enter a file name.

Open the Save as type pull-down menu, and select the file format.

Click Save.
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Exporting and
Importing
Objet Build
Trays
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When you save build trays in Objet Studio, they are saved as objtf files.
These files contain instructions to Objet Studio and to Objet printers for
displaying and producing the st! files used on the tray. To conveniently
save all of the files that comprise the build tray, for storing the job, or for
transferring it to another location, Objet Studio compresses them into one
objzf file. To later use the objzf file, the file must first be expanded in Objet
Studio and its component files saved.

Note: If you export an objzf file containing a stl file originally saved as read-
only, you cannot open (import) this objzf file to the folder where the
read-only stl file is saved.

To create an objzf file:

1. From the Objet Studio Commands Menu menu, select Export Packed
Job.

The Save As dialog box opens.

2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an objzf file:
» Double-click on the objtf file.
or—

1. From the Objet Studio Commands Menu menu, select Import Packed
Job.

2. Inthe Open dialog box, display the appropriate folder and select the
file.

3. In the Browse for Folder dialog box, display the folder in which you
want Objet Studio to expand the compressed file, and click OK.

The objtf file and associated st! files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.

Note: You can also export a print job as an objzf file from the Job Manager
screen—see “Exporting Jobs (objzf)” on page 69.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

Creating a
Quick Access
Toolbar

5-46

* Creating a quick-access toolbar for frequently used commands.
* Changing the position of the Quick Access toolbar.

* Minimizing the ribbon.

* Changing the Objet Studio color theme.

* Configuring default settings for objects placed on the build tray.

As you work with Objet Studio, you may use certain commands frequently.
You can create a quick-access toolbar to make your work easier.

To create a quick-access toolbar:

1.

Above the ribbon tabs, click = .
The Customize Quick Access Toolbar menu opens.

Customize Quick Access Toolbar
Insert
Flacement:
Estimate
Build
Qpen...

More Commands. ..

Show Eelow the Ribbon

Minimize the Ribbon

Figure 5-63: Customize Quick Access Toolbar menu

2. Select a command you want to add to the toolbar.

An icon for the selected command is added to the toolbar.

e O

Tray Settings Job Mana

B e &3 S

Insert | Placement Yalidate Estimate Build

Model Build Process

Figure 5-64: Quick Access toolbar

To add another command, repeat the above procedure.
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Hiding the
Ribbon
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4.

5.
6.

3. To choose from a wider range of commands:

From the Customize Quick Access Toolbar menu (see figure 5-63 on
page 46), select More Commands.

or—

* Right-click on the Objet Studio Commands icon, or elsewhere on the
ribbon, and select Customize Quick Access Toobar.

Cuskomize Quick Access Toalbar, ..
Shiowe Quick, Access Toolbar Below the Ribbon
Minimize the Ribbon

Figure 5-65: Right-click ribbon menu
The Options dialog box opens.

[ custonize |

Chonse commarnds frarm:

Popular Cormands | |42 Job Manager.
Commands
<Separator>
@ Automatic placement
> Buid
5 Insert Model

o z
& Open
& Placement validation -
B sane

] Shew Quick Access Tookar below the Ribbon

Kepboard shartouts:

Figure 5-66: Quick Access Toobar Options dialog box

Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

Select a command and click Add.
Click OK.

To make more room for displaying the build tray, you can hide the Objet
Studio ribbons.

To hide the ribbons:

1.

Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands Menu () -

Select Minimize the Ribbon.
The ribbons disappear, but you can temporarily display the ribbon

icons by clicking Tray Settings or Job Manager on the menu bar. When
you next click outside of the ribbon, it disappears again.

To return the permanent ribbon display:

> Repeat the steps above to cancel Minimize the Ribbon.
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Display Colors
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You can customize some of the colors used for displaying Objet Studio
screens and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:
1. From the Tools menu, select Options.
Options (e

Appearance |Grid | Manipulate | Display | Seftings |

Select Indication

Color l:l

[ Transparert

Window’s Background Color
() Color l:l
®Gadent | [ |

[ ok |[ cancel || pply

Figure 5-67: Display settings

2. In the Appearance tab of the Options dialog box, you can configure the

display.

* The Mode selection determines how models appear on the build
tray. The default method for displaying models on the build tray is
as solid (“shaded”) objects. The other options are WireFrame and
Points.

* If Shaded is selected, you can display the model on the tray as a see-
through object.

|
Figure 5-68: Transparent display

* Double-click the color patches to customize colors.

* The Windows Background Color settings enable you to change the
color behind the build tray —with either a solid or a two-color
gradient.

* To return to the default display settings, click Default.
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Changing Color Objet Studio offers a choice of four background color themes—blue, black,
Themes silver and aqua.

QR Q" s

A EVIS B wid

< N N <

Figure 5-69: Background color themes

To change the color theme:

* From the Style menu, select one of the options.

Keyboard You can define shortcut keys for frequently used commands.

Shortcuts To define shortcut keys:

1. Above the ribbon tabs, click = .
The Customize Quick Access Toolbar menu opens.
&

Customize Quick Access Toolbar

Insert
Flacement:
Estimate
Build
Qpen...

More Commands. ..

Show Eelow the Ribbon

Minimize the Ribbon

Figure 5-70: Customize Quick Access Toolbar menu
2. Select More Commands.
The Options dialog box opens (see figure 5-66 on page 47).
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3. Click Customize.
The Customize Keyboard dialog box appears.

Categories: Commands:
~
Frint Presview Build Properties

Amrange Tray Default Properties..
Model Settings Exit
Job Manager Export Packed Job.
Import Packed Jab...
Job Manager...
M achine Properties w
Current Keys: Press new shartcut key

Home

Aszighed to
[Unagssigred]
Set Accelerator for:
Description:
Build

Figure 5-71: Customize Keyboard dialog box

4. Select command Categories to display all the commands in that
category, for example, all the Model Settings commands.

Current shortcut keys are displayed.

5. Enter the shortcut key in the Press new shortcut key field, and click
Assign.

6. If you want to redefine all shortcut keys, click Reset All.
Setting User You can change several Objet Studio settings that affect objects placed on
Preferences the build tray.

To change default settings:
» From the Objet Studio Commands Menu, select User Preferences.

User Preferences Pz|
Building Style Grid Style
(3) Matte (%) Standard
() sy (I Heawy
O Lite
Application Settings
[Lock Orientation
ot

Cancel

Figure 5-72: Setting work preferences

* Building Style—see “Surface Finish” on page 17.
* Grid Style—see “Using a Grid to Position Objects” on page 23.

* Application Settings —see “Choosing the Support Strength” on page 41,
and “Freezing Model Orientation” on page 28.
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Professional Mode Features

Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:
» Open the Tools menu.

Tools =|style - (@) -

Grid
Snap ko Grid

Constrainks Setkings...

Section

Flane alignment 3

V' | Professional Mode

Language...
Options. ..

Define Colors, ..

Figure 5-73: Tools menu, showing Professional Mode selected
If Professional Mode is selected, advanced features are displayed.

To change the Professional Mode setting:
1. From the Tools menu, select Professional Mode.

The following message is displayed, reminding you that the change
will only take effect the next time you open Objet Studio—even though
the check mark next to the Professional Mode option appears
immediately.

L E The configuration changes vou have made will not take effect until the next time wou run the application,
L

Figure 5-74: Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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Default
Settings

Automatic
Orientation

Automatic Zoom
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You can control the default settings of several Objet Studio features from
the Advanced tab of the Options dialog box.

To display the Options dialog box

» From the Tools menu, select Options.

or—
In the Objet Studio Commands Menu, click Options.
Options g|
Appearance Grid M anipulate Dizplay
Settings Advanced Troublezhooting
[ suto Zoom

Orient Objects dutamatically

[ Ok H Cancel ]

Figure 5-75: Options dialog box, Advanced tab

By default, when Objet Studio places objects on the build tray, it orients
them optimally, for the shortest printing time. If necessary, you can choose
to cancel automatic orientation each time you place an object on the build
tray (see “Automatic Orientation” on page 18). In any case, when objects
are on the build tray, you can change their orientation manually, if
necessary —see “Model Orientation” on page 20.)

To change the default setting so that Automatic Orientation is disabled:
» In the Advanced section of the Options dialog box, clear the check box.

When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms in, to display the objects placed on the build tray.
This allows you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the
zoom level, as necessary (see “Zoom Options” on page 36).

DOC-34015 Rev. B



Objet30 User Guide

Open GL The OpenGL driver displays 3D graphics on your screen. There is normally

Driver no reason to adjust its settings. If you suspect a problem with the way Objet

Configuration  Studio displays objects, you can use the OpenGL Driver Configuration tool
to check and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands Menu, click Options.
2. Inthe Options dialog box, display the Troubleshooting tab.

Options g|
Appearance Grid Manipulate Dizplay
Settings Advanced Troubleshooting

OpenGL Driver Configuration. ..

[ (] 8 ][ Cancel ]

Figure 5-76: Access to GL-driver configuration

The Troubleshooting tab is only accessible when Professional Mode is
active (see “Professional Mode Features” on page 51).

3. Click OpenGL Driver Configuration.

The dialog box that opens displays details of the pixel format ID (index)
for the window and the memory.

X

OpenGL Driver Configuration

Window Pixel Format | Memony Pixel Format | Advanced

() Pixel Format D
(¥ Choose Format | Option 1 v
Color Bits 24
[epth Bits 32
Alpha Bits 0
[ Ok ] [ Cancel ]

Figure 5-77: OpenGL Driver Configuration dialog box

If you want to display the values and change them, click L=d. Alternately,
you can select Choose Format and change the values in this dialog box.

DOC-34015 Rev. B 5-53



Using Objet Studio

To perform a test of the driver configuration and enter the suggested
pixel format ID:

1. Select Choose Format.
2. Click Test.

Objet Studio returns the recommended pixel format ID.

Objet Studio X

.
\}4) Choose Pixel Format: 5

Figure 5-78: Recommended pixel format ID

Click OK.

4. Inthe OpenGL Driver Configuration dialog box (figure 5-77), select
Pixel Format ID and enter this number.

Click Apply.
6. Display the other pixel format tab, and repeat this procedure.
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Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen instructions and information, as you
work.

To view Objet Studio Help:
> On the standard toolbar, click ®©' and then click Objet Studio Help.

Tools = Style ~| @)~

Objet Studio Help

Troubleshooting
Check for Updates

@ pbout...
Figure 5-79: Help options
You can also view information on the following subjects:

* Troubleshooting opens a list of error messages and their
explanations.

*  Check for Updates checks if you are using the latest Objet Studio
version.

Objet Studio Version, Material Module and Licensed Features

You can view details of the Objet Studio version, the material module
installed, and the features available with your license.

To view details of your Objet Studio installation:

» On the standard toolbar, click @ and then click About....

Tools = Style ~| @)~
Objet Studio Help

Troubleshooting

Check for Updates

Figure 5-80: Displaying Objet Studio details

About Objet Studio  The About Objet Studio tab shows the Objet Studio version number and
tab basic information about your computer.

e] S|

About Objet Studio | Materials Module I Feature License|

(IBJET

Obijet Studio Ver. 9.2

Copyright © 2013 Stratasys Ltd.
All rights reserved.

For Applications Support: applications-nkjet @stratasys.com

Operating System:  Professional -Service Pack 1 (Build 7601)-

Processor: Pentium 1V+
Awvailable Physical Memory: 515 MB
System Resources: B4

Figure 5-81: About Objet Studio tab
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Materials Module The Materials Module tab shows details of the material module installed.

tab

Feature License

5-56

tab

o

S

About Objet Studio | Materials Module | Feature License

Module version:  9.2.7.7
Module Date: 28.01.2013

Module Properties: Default

Figure 5-82: Materials Module tab

Module version

If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module
version is the same as the Objet Studio version.

Module date

If a Materials Module upgrade (patch) was installed, the date of its
creation is displayed. If no patches were installed, the Module date is the
date of the Objet Studio version.

Module properties

If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.

The Feature License tab shows the Objet Studio features available with your
license.

o

S|

| About Objet Studio | Materials Moduls | Feature License

(- Modes
[ Materials
[ Mixed trap

Figure 5-83: Feature License tab

Click [#] to expand the details for each feature.

Modes shows the printing modes available.

Materials shows model materials available.
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Monitoring and Managing Print Jobs

W=

Job Manager

In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on
client workstations and on the computer connected directly to the 3D
printer —the server workstation.

* Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3D printer server from that computer, and it
allows the user to edit only these jobs.

Note: If there are several Objet printers on the local network, client
computers can connect to any of them, but only one at a time.

* Objet Studio installed on the computer directly connected to a specific
3D printer (server), displays the queue and status for all jobs sent to that
3D printer by the server and by all client computers on the network. It
also allows editing and manipulation of all jobs, and enables re-sending
previously-printed jobs to the printer.

If Objet Studio is not connected to a printer (or printer server), you can
prepare tray files for any Objet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.

The Job Manager screen on the client and server workstations looks

Screen identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.
¥
Job Manager—] = -
Ribbon
- - s .
Jobs Queue—
S Available
Print Progress—{ | smesusen —  resources
............................................................................. 1
E B S | Materials
Print History—| s consumption

Waste status
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._.I ! ) f/ | Tray Preview

The Job Manager screen is divided into panels:

Figure 5-84: Job Manager screen

* Jobs Queue

* Printing Progress

* History

* Available Resources

* Material Consumption
* Tray Preview

¢ Waste
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Jobs Queue

Printing Progress
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History

Available
Resources

Material
Consumption

Tray Preview

Waste

On the server, the Jobs Queue lists the last 15 jobs sent from client
computers. On client workstations, the Jobs Queue lists jobs sent from that
computer to the printer server.

Information for each of the queued jobs is displayed, including the job
status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be

continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was
placed in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing  The 3D printer is readying itself for printing: the cover
locks, print heads warm up and are put in starting
position, UV lamp is turned on, and the build tray level is
adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:
* Owner—the computer that sent the job.
* Build Time—the estimated building time for the job.

*  Model Consumption—the amount of model material required to
complete the job, and the amount actually used till now.

*  Support Consumption —the amount of support material required to
complete the job, and the amount actually used till now.

The Time panel shows printing times and the number of slices sent to the
printer.

The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.

The Available Resources panel contains graphic indicators that show the
amount of available printing material remaining.

* Actual—the amount of material used till now
* Required—the amount of material still needed to finish the job

The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see “Extended Tray Preview” on page 67).

If you move the mouse over the Waste display, the amount of waste in the
container is displayed.
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Setting the When an Objet 3D printer is installed, the server computer is connected to
Printer that printer. Normally, there should be no reason to change this connection.
Connection Occasionally, however, you may need to reset the connection, to connect

the server to another printer, or to use Objet Studio in off-line mode
(without a printer connection).

To set (or change) the printer connection: )
1. On the Job Manager ribbon, in the 3D Printer group, click cenect,
2. In the Set Printer dialog box, click Connect.

Printer

=-Desktop

Objet30

. Objet24

. . Objet3D Scholar

i ..Objet30 Pro

¢ 1.0bjet30 OrthoDesk
i i-Eden 500¥ |
© Eden 350V |
. L.Eden 260V

£- Connex

- Connex500

- Connex350
--Objet260 Connex
- Objets00 Connex3
-- Objet1000

Ceomen.)

—

Figure 5-85: Connecting to a printer (A)

3. Enter the computer name or its IP address, or click Browse to find and
select it.

WM.B —
2 — [

Enter printer name/|P address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-86: Connecting to a printer (B)
4. Click OK.

When the connection is established, Objet Studio is configured to
prepare print jobs for that printer.

Objet Studio is connected to the printer if you can see the material levels in
the Job Manager screen (see figure 5-84 on page 57).
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Off-line Mode  You can use Objet Studio to prepare trays for printing in off-line mode, on
aremote computer or when the printer connection is not available. You also
use off-line mode to prepare trays for printing with other printers. In this
case, if Objet Studio is currently connected to a printer, you must change to
off-line mode by removing this connection.

To disconnect Objet Studio from the printer: )
1. On the Job Manager ribbon, in the 3D Printer group, click cenect,
2. In the Set Printer dialog box, click Connect (see figure 5-85).

Printer

=- Desktop

- Objet30

- Objet24

- Objet30 Scholar

- Objet30 Pro

- Objet30 OrthoDesk
- Eden 500V

 Eden 350V |
- Eden 260V

=- Connex

- Connex500

- Connex350

- 0bjet260 Connex
- 0bjethlld Connex3
- Objet1000

o ——.

(Gomert)

S —

Figure 5-87: Disconnecting Objet Studio from a printer (A)

3. In the Printer Connection dialog box, delete the computer name/IP
address.

2 — [

Enter printer name/|P address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-88: Disconnecting Objet Studio from a printer (B)

4. Click OK.
“Unknown” appears in the printer-name field.
5. Click OK.
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6. Inthe pop-up message, confirm that you want to work in off-line mode
by clicking No.

M Job Manager

i ) Ohijet Studio is in off-line mode.

Do wou want ko connect ko a 30 prinker?

Figure 5-89: Off-line message
When Objet Studio is in off-line mode, you can configure it for preparing
print jobs for different printers.
To change the Objet Studio off-line configuration:
1. In the Set Printer dialog box, select a printer type.

Printer

- Desktop

. . Objet3D

- Objet24

-- Objet30 Scholar

-- Objet30 Pro

-- Objet30 OrthoDesk

: e —Y
Cox D
. . Eden 500V —— |
. -Eden 350 |
i i-Eden 260¥
- Connex

- Connexb00

- Connex350

Objet260 Connex
Objets00 Connex3
Objet1 000

Figure 5-90: Off-line printer selection
2. Click OK (not “Connect”).
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Setting the
Remote Printer
Connection
(Client Mode)

Job Manager
Commands
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When you open Objet Studio for the first time in a client installation, you
are prompted to connect to an Objet server computer that sends jobs to a 3D
printer. To do this, the server computer must be operating and connected to
the local network.

To set (or change) the connection to the server-computer:

1. On the Job Manager ribbon, in the 3D Printer group, click

Connect*

2. Enter the name of the server computer or its IP address, or click
Browse to find and select it.

3. Click OK.

rFi
,j--._; < _._/“_)L -

Specify Server Computer name/|F address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-91: Printer Server Connection dialog box

The Job Manager ribbon has three icon groups:
¢ 3D Printer
* Queue
e Job
P ¢ Fadd e0BBS

Connect Motifications | Top Up  Down Botbom | Restart Stop Resume Delete Wiew  Edit

30 Printer Queue Job

Figure 5-92: Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example,
you cannot stop printing a job that is not being printed, so the Stop
command is disabled.
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The following operations are available on the Job Manager ribbon:

Group Icon Purpose
3D [_';5 Client: Sets the server connection. See “Setting the Remote
Printer " Printer Connection (Client Mode)” on page 62.
Server: Sets the printer connection. See “Setting the Printer
Connection” on page 59.
.. Configures options for printer alerts. See “Configuring User
nrcations Alerts” on page 65.
Queue Iﬂ Server: Moves a job to the head of the Jobs Queue.
Top Client: Disabled.
See “Jobs Queue” on page 58.
\A Server: Moves a job to a higher position in the Jobs Queue.
Up Client: Disabled.
See “Jobs Queue” on page 58.
\ﬂ Server: Moves a job to the bottom of the Jobs Queue.
gottom Client: Disabled.
See “Jobs Queue” on page 58.
Iﬂ Server: Moves a job to a lower position in the Jobs Queue.
G Client: Disabled.
See “Jobs Queue” on page 58.
Job & Server:

Restark

* For ajob in the Jobs Quene—Prints it again (from the
beginning).

* For ajob in the History list—Moves it to the Jobs Queue
for printing.

Client: Disabled.

See “Restarting Jobs” on page 68.

Server: Stops a job in progress.
Client: Disabled.

Skop

@; Server: Continues printing the current job from the point
. where printing stopped.

esme

Client: Disabled.
See “Resuming Jobs” on page 68.

Removes the selected job from the queue.

Drelike:

2%  Refreshes the image of the selected job in the Tray Preview
= display.

Vigw

_.»  Opens the ngl Settings screen and displays the tray. For

%= deleted jobs, this enables you to make changes before

Edit printing.
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In addition to using ribbon command icons, you can use commands on
context (pop-up) toolbars and from the Job menu on the standard toolbar.

Restart \

Stop d Ei_ Delete
» i

Edit « B ¥ | Resume

Export - Schedule

packed job

Figure 5-93: Icons on pop-up toolbar (server)

E Delete

Edit ——— .

Figure 5-94: Icons on pop-up toolbar (client workstation)

Note: Most icons and menu commands are only enabled when a job is selected.

When you position the cursor over an item, a tooltip displays the name of
the command.

Job = Tools = Skwle -

% sStop...

*. Delete Job...

Show 3dProgress

. Export ...

Figure 5-95: Job menu options (server)
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Configuring
User Alerts
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Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:

* The level of model or support material is low.
* The job was interrupted.
* The job was completed successfully.

To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e-mail messages by SMS.

Only the subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

et
1. On the Job Manager ribbon, in the 3D Printer group, click Hetfieations

Notifications El
Sound Alert
@ (5) Woice Messages (3 PC Speaker
7

Fieport to Printer

HP Desklst 3300/9320/9350 [ Pines. |
Fiepart to e-mail
dd Recipient

Remove Recipient

Add Recipient

[ Riepot via SMS

Q RemindMe 15min | Before Cartridges Emply

Q RemindMe 100g | Befors Cartridges Empty
oK. Cancel

Figure 5-96: Notifications dialog box (server)

Notifications @

Sound Alert
@ @) Voice Messages ) PE Speaker
28

[ Report to printer

Fieport to e-mail
#dd Recipient
Remove Recipint

[ Report via SMS

Figure 5-97: Notifications dialog box (client workstation)

2. Set the desired reporting options.
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Server
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3. Click Details.

4.
5.

X

Select Events to repart on;
Sucoessful job finish
Job interruption

End of kMaterial rerminder

I Ok ] [ Cancel ]

Figure 5-98: Event selection for alerts

In the Reports Events dialog box, select the alert events and click OK.

In the Notifications dialog box, click OK.

If there is a job in the Jobs Queue, it is sent automatically to the Objet
printer—as long as it is on, there is a connection to the printer, and the
printer is on line. Chapter 6 describes starting and operating the printer.

Objet Studio on the printer server includes the following additional
features:

These features are described on the following pages.

Extended Tray Preview

Editing Jobs

Restarting Jobs

Resuming Jobs

Scheduling Jobs

Exporting Jobs (objzf)

Modifying the Job Manager Screen
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Extended Tray Preview

In this window, you can view the tray from different angles and
magnifications without leaving the Job Manager screen. In addition to
displaying the selected job in the Tray Preview pane, you can open an
enlarged build tray window.

To display the build tray window:
1. Select a job in the Jobs Queue or the History list.
2. Click the Tray Preview pane.

VHYIYEOE @D

Figure 5-99: Job Preview

* To change the tray magnification, turn the mouse wheel.

* To view the tray from a different perspective, click the relevant icon.
* To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double-click on the object you do not want to print.
2. Display the Build tab.

3. Select Exclude from Build.

2-0148.5tl

| Info | Options | Build

Exclude from Build

0Objet Studio

Figure 5-100: Excluding a model from the build

4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display
objects as they are printed, layer by layer. This enables you to visually
monitor printing progress on the computer screen.
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To display printing progress in the Tray Preview pane:
» From the Job menu, select Show 3dProgress.

%( This option uses additional system resources.

Editing Jobs

You can open jobs in the Jobs Queue for editing.

To edit a job:

1. Select the job. -

2. Click the Edit icon o .
The Tray Settings screen opens, displaying the build tray. The status of
the job in the Job Manager screen changes to “Editing.”

3. Edit the job. s
On the Tray Settings ribbon, click e -
The status of the job in the Job Manager screen changes back to
“Waiting.”
Restarting Jobs
You can restart jobs from the Jobs Queue and the History list.
To restart a job:
1. Select the job. :
e
2. Click the Restart icon restart .
The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs

If the printing process is stopped or interrupted, you may be able to
continue printing the job from the point where printing stopped.

To resume a job:
1. Select the job. _
2. Click the Resume icon esme.
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Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and
early morning hours.

To schedule a job:
1. Select ajob in the Jobs Queue, and click € on the pop-up toolbar.
2. Inthe Scheduler dialog box, set the Start Date and Start Time for the job.

Click on the Start Date arrow to open a calendar.
f X

Iv Start Printing job in schedule:

Start Date: Sunday  11/04410 -
B apiizonn 3

Sun Mon Tue Wed Thu Fri Sat |-
T2 3|

4 5 B 7 & 9 10

[ 12 13 14 15 16 17
18 19 20 21 22 23 24

28026 27 28 29 ;W J

—2 Today: 4/11/2010

Figure 5-101: Scheduler with calendar displayed
3. Click OK.

Exporting Jobs (objzf)

You can save print jobs as compressed files.

For an explanation of objzf files, see “Exporting and Importing Objet Build
Trays” on page 45.

To export a print job:

1. Select a job.

2. On the pop-up toolbar, click &

3. In the Save As dialog box, selg a folder.
4. Click Save.

Moditying the Job Manager Screen

You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:

* the Jobs Queue panel
* the Time panel
* the History panel

Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.

* C(lick again to display the panel.
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Operating & Maintaining the
Objet30 3D Printer

Starting the Objet30 Printer ..........cccocveivnivininiiininnicicce, 2
Loading Model and Support Cartridges.........c.cccocouvvrnniniininiicnnnns 4
Producing Models ..o 6
Printer Interface Color Key ........cccoviiiiiiiincccicccccces 8
Printing INdicators ... 9
Resuming Production After Printing has Stopped....................... 10
Changing the Model Material ...........cccccocoviiiiiiiiiiiiiiiiins 12
Keeping the Printer in Idle Mode ..........ccconniniiiiiiiiins 18
Shutting Down the Printer........cccccooviiinnicce, 19
Shutdown Wizard ... 19
Material Flush/Fill Wizard...........ccocoovriiiiiiiiccnen 21
Maintaining the Printer ..., 24
Routine Maintenance Schedule.............cccocoviiiiiiiinnnniiccne. 24
Cleaning the Print Heads.........ccccovniiiiiinniicice 25
Pattern Test ... 27
Improving Print Quality ..., 28
Cleaning and Replacing the Wiper...........ccccccccvvinnviiiiiincinninennnes 29
Cleaning and Replacing the Roller Waste Collector .............c.c..... 32
Aligning the Print Heads ........ccccccovviiiiiiie, 35
Optimizing (Calibrating) Print Heads .........ccccoovvvviiiinnnnnnn 39
Replacing Print Heads.......ccccooveviiniiiiciiiciiciccccccce 46
Testing and Calibrating the UV Lamp .......cccoovvevvvreireniniicciinnen, 56
Calibrating the Load Cells ..........cccoouieiririeiiinincccceeee 59
Replacing the Odor Filter.........ccccovinirniiiniicicce, 61
Replacing the UV Lamp ......ccccovvinreinirniicicccccccceeeees 62
Built-in Tests.......ccoviviiiiiiiiiiiiicc 66
Replacing the Waste Container ...........c.coevvueueucuccccnninececrcncccnnes 68
Cleaning the Exterior Panels ..........c.cccocceeiuiiinnninniiicciininne 70
Backing-Up and Restoring Printer Settings ..........cccocoeueucuiuicnnacne. 70
Relnitiate Wizard ... 70
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Printer cover

Materials drawer

Printer stand

Figure 6-1: The Objet30 3D Printer

Starting the Objet30 Printer

& CAUTION!
* Do not attempt to operate the Objet printer before being trained by a
Stratasys customer-support representative.

* Observe all safety warnings and follow the safety guidelines described in
chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2: Main power switch and cable

The main power switch turns on the Objet printer, which includes —
the built-in computer.

2. After the computer boots, open the Remote Desktop Connection on the
server (“host”) computer, by double-clicking the Printer computer
shortcut.
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Printer mode

Online/offline button

Stop button

Support material
cartridges

3. Launch the printer-control application:

* On the printer-computer desktop, double-click the Objet printer
icon.

or—

* From the Start menu, select (All) Programs > Objet > Objet.
A HASP plug containing a valid product activation key is required on the
printer computer. This is installed at the factory or during printer upgrade. If

the application does not open and a HASP message appears, contact your
dealer or Stratasys Customer Support.

The Objet printer interface screen opens (see figure 6-3). All monitoring
and controlling of the printer is done from this interface.

File_Options_Help _x |

" Ystratasys

Current activity

Display
toggle button

] @B]ET Fullcure7os Wl

3

DOC-34015 Rev. B

280 gr ‘
FullCure705 L __J
— 620 gr

VeroWhite Model material
cartridges

Figure 6-3: Objet30 interface

The time zone on the printer computer is factory-set and it cannot be
changed. Similarly, the computer’s clock cannot be configured to
automatically change the time for different seasons of the year. If necessary,
you can change the displayed time manually, but do so only when the
printer is idle.
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Loading Model and Support Cartridges

6-4

S

Objet30 printers use two cartridges of Model material and two cartridges of
Support material, each weighing one kilogram when full. A graphical
representation of the cartridges loaded and their current weight appears in
the printer interface (see figure 6-3).

Note: The printer-control interface displays the type and weight of the
material cartridges loaded only if the materials drawer is closed.

The printer uses RFID technology to automatically identify cartridges of
printing material. For this purpose, an RFID module is part of the printer
hardware. Tampering with this module will render the printer inoperable and
may void Stratasys warranties and service contracts.

Important: If you need to replace the Model material currently
installed with another type, see “Changing the Model Material”
on page 6-12. Otherwise, make sure to replace the Model
cartridge with one containing the same type of material.

To load Model and Support material:

1. On the front of the printer (see figure 6-1), push the materials drawer to
release it and pull it open.

2. If you are replacing a cartridge, remove the old one by pulling it
straight up.

3. Load Model and Support cartridges into their respective
compartments (see figure 6-4).

Support2 | . . IModel 2

Figure 6-4: Materials drawer

4. Close the materials drawer.
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5. Check the printer interface to make sure that the new cartridge is
detected and that its weight is displayed (see figure 6-3).

Tips about replacing cartridges:

* You can replace material cartridges either before or during printing. If you
do so while printing, make sure to load the new cartridge and close the
materials drawer within three minutes. This ensures that the print job is
not interrupted. (When the drawer is open, the cartridges are not
displayed in the printer interface.)

* If printing stops for an extended time before you replace a material
cartridge, the printer may go into Standby or Idle mode. If this happens,
see “Resuming Production After Printing has Stopped” on page 10.

* You can replace partially used cartridges to avoid the need for replacing
them during printing. However, repeated removal and installation of a
cartridge may cause the material in it to leak. Therefore, it is
recommended that you limit the re-installation of used cartridges.

* You can load partially used cartridges, as long as they contain more than
100 grams of material.
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Producing Models

The Objet30 printer produces models by printing tray files prepared in the
Objet Studio application and sent to the printer from there. For information
about preparing model files for printing, see “Using Objet Studio” or Objet
Studio Help.

The Objet30 printer is capable of printing models with the following
maximum dimensions:

* With glossy finish—
X-axis: 294.00 mm (11.57 inches)
Y-axis: 192.00 mm (7.55 inches)
Z-axis: 148.60 mm (5.85 inches)*
* OrthoDesk printers —100.0 mm (3.94 inches)
* With matte finish—
X-axis: 293.00 mm (11.53 inches)
Y-axis: 191.00 mm (7.52 inches)
Z-axis: 148.30 mm (5.83 inches)*
* OrthoDesk printers —97.9 mm (3.85 inches)

current printing quality of the print heads by performing a pattern test (see

Before beginning to produce models, it is recommended that you check the
'\ “Pattern Test” on page 27).

To prepare the printer for producing models:
1. Make sure that the build tray in the printer is empty and clean. If not,

remove cured material with the scraper, and clean the tray thoroughly
with a wet cleaning cloth.

CAUTION: Use protective gloves when cleaning the build tray, and be
careful of the sharp edges of the scraper blade.

2. Make sure that there is sufficient Model and Support material loaded,
as indicated in the printer interface (see figure 6-3). You may want to
replace the cartridges of Model and Support material currently loaded
in the printer to avoid the need for replacing them during printing.

For installing material cartridges and replacing empty ones, see
“Loading Model and Support Cartridges” on page 6-4.
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3. On the printer interface, click the red button to switch the printer to
online mode.

The color of the button changes from red to green (see figure 6-7). If
there is a job in the Job Manager queue, it is sent to the printer.

In the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:

* The print block is heated.

* If more than 48 hours have passed since the last print job, the printing
materials in the print heads are flushed and replaced, to ensure quality
printing. (This step adds 7 to 14 minutes to the Pre-print cycle, and it is
displayed in the printer interface.)

Figure 6-5: Relnitiate process during the Pre-Print cycle

* The UV lamp is powered and it warms up.

When printing begins, Objet Studio sends seven slices to the printer. This is
the standard buffer between Objet Studio and the printer. As each slice is
printed, another slice is sent to the printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough Model
and Support material in the supply cartridges, printing proceeds
automatically until the job is finished.

During printing, the server computer must remain on and it must
communicate with the Objet printer. Do not log-off Windows until printing is
finished.

The Objet printer uses one Model-material cartridge and one Support-
material cartridge to produce models. When four cartridges are loaded in
the printer, two of them are reserve, or standby, cartridges. By default, the
printer first uses the cartridges with the least material in them.

» The active cartridges are blue in the printer interface.

When the weight of a cartridge drops below 100 grams, the remaining
material displayed in the printer interface is red. The printer then alternates
the pumping of material between the heavier and the almost-empty
cartridge. This is indicated in the printer interface by an hour-glass icon.
(See figure 6-8 on page 9.)

When a cartridge is completely empty, a trash icon is displayed.

_ VeroWhite _

3

Figure 6-6: Empty cartridge indicator
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You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button in the printer interface
screen.

Block temp.

[ File_Opfions_Help e
behind ?‘" Stratasys System

vacuum level

) !—ie:ds(“(:) e S:nsnr: ]
Support head | T | vacuum G UV lamp state
Msintenance | g0 ort Waste(gr) [EEER | M Waste weight
Temp. of G Ambient (°C) E| Chamber temp.

Model head

Heads Liquid [T

Block temp. | Model/Support
in front of material in print-
print heads block reservoir

Verowhite FullCure705

Printer setto | ' o
online mode | @BJET = O |
(green)

| Display
|

toggle button
280 | . .
FullCure705 Active material

cartridges (blue)

n ‘ ‘ Reserve material
{ ; | | cartridges (gray)

640 gr

Figure 6-7: Printer indicators

Printer The background colors in the printer indicator fields tell you at a glance
Interface whether or not the value or item is suitable or ready for printing.
Color Key * Green—suitable/ready for printing

For example, in figure 6-7:

O Ambient—The ambient temperature of the printing chamber is
within the acceptable range.

O Heads Liquid—The level of Model and Support material in the print-
block reservoir is OK.

O Vacuum—The vacuum level in the system is within the acceptable
range.

* Red—not suitable for printing (or indicates a warning)
For example, in figure 6-7:

O Waste—The weight of the waste container is 7300 9000 1520 grams,
more than allowed when beginning a print job. (See “Replacing the
Waste Container” on page 6-68.)

* Blue—not ready
For example, in figure 6-7:
O UV lamp—The UV lamp is not on.

O Heads (°C)—The heads have not reached the temperature required
for printing models (in printing mode).

The color of the material cartridges displayed in the printer interface
indicates which cartridges are active for the current (or next) print job.

* Blue—active cartridges

* Gray—reserve cartridges

DOC-34015 Rev. B



Objet30 User Guide

Printing The printer interface screen changes when you send a print job from Objet
Indicators Studio to the printer, and the printer is on line (see figure 6-8):

* The mode changes from Pre-print to Printing.

* The specific activity being performed is shown in the “current activity”
field.

* Current job-printing information is displayed.
* The printing progress bar is displayed.
* The Stop button is enabled.

N

File_Optians _Help _x
20 Dec 2012 11:36

' Vstratasys

Printer mode Current Activity

Stop button
,‘I‘ @BJET \ : J ‘— FullCure705

280ar

FullCure705 —
e 620 gr

MerdWhite. Distributed
pumping

Almost empty

Figure 6-8: Printer interface during printing

During printer operation, the following window may occasionally appear.

# QMonitor
Options

Figure 6-9: Q-Monitor

This window records information for service personnel only, and it does
not require your attention. You can close or minimize it to remove it from
view.
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Resuming Production After Printing has Stopped

If the printing process is interrupted, Objet Studio stops sending slices to
the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you don't replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the Job Manager screen of Objet Studio.

print heads is reduced. About 20 minutes later, the printer goes into Idle

After printing stops, the printer goes into Standby mode, when heating of
i \ mode, when heating of print heads is stopped.

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see figure 6-3 on
page 3).

The button changes from red to green (see figure 6-7 on page 8).

2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.

3. In the Job Manager screen of Objet Studio, click the Resume icon e

Resume *

4. In the Continue from Slice dialog box that appears, confirm the slice
number, after checking the printer interface.

File Options Help _ X |
20 Dec 2012 11:36

& Stratasys

Printer mode

Last slice
[ printed

Figure 6-10: Printer interface after interrupted printing

Continue from Slice:

278

ook | l Cancel ]

Figure 6-11: Continue from Slice confirmation in Objet Studio (Job Manager
screen)

5. If, for any reason, the correct number does not appear in the dialog
box, enter the number and click OK.
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You cannot continue printing the model if:

* The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Continue from Slice
confirmation dialog box.

* There was a relatively long interruption in printing, even if the “last
slice” and “continue from slice” indicators are correct. The part of the
model already printed may deform or shrink, and there might be a
visible difference between it and the newly printed part. The effects of a
printing stoppage on a model depend on the model size and structure,
Model material used, ambient temperature and the length of the

stoppage.
If you cannot continue printing:
1. Cancel the print job in the Job Manager screen.
2. Remove the partially printed model from the build tray.
3. Restart the job from the Job Manager screen (in Objet Studio).

Manager screen of Objet Studio. Resuming printing is only available from

You can stop printing from either the printer interface or from the Job
'\ the Job Manager screen.
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Changing the Model Material

Before producing models using a different type of Model material than is
currently installed, run the Material Replacement Wizard to flush the print
block and feed tubes.

avoid unnecessary waste of the materials currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are

Q You should carefully plan printing models with different Model materials to
replacing one or both Model cartridges. For details, see page 14.

To replace the Model material:
1. Start the Material Replacement Wizard from the Options menu.

File Options Help _ % |
Go ko Tray Upper Position FS
Gaoko Service Position F&
Wipe F7

' Stratasys

Execute Purge Sequence  F4

Pattern Test F3

Head Alignment

Built In Tests... ChrHal+E Heads Cleaning

Head Optimization

Load Cell Calibration

Material Flush/Fill Wizard

Shutdowin Wizard F3 Materi ent |
\@J = Relnltlrate ) |

— U Calibration
L Lamp Replacement
Wiper Cleani

Maintenance Counters. ..
Collect Service Data Fz

Figure 6-12: Starting the Material Replacement Wizard

In the opening screen, click Next.

3. If the printer cover is not closed, a screen appears, prompting you to
close the cover. Confirm that it is closed and click Next.

4. When the Cartridge Loading screen appears, indicate whether or not
replacement cartridges have been loaded.

Material Replacement Wizard

Cartridge Loading
Flease select:

(%) Replacement cartridge(s) nat yet in printer.

() Replacement cartridge(s) in printer.

-/ Stratasys

’ X Qancel] ’{Erevious” Mext ]

Figure 6-13: Replacement-cartridge status
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5. Click Next.

If the replacement cartridges are already loaded in the materials
drawer, a screen appears, showing the materials currently in the

system and the material cartridges in the drawer.

Material Replacement Wizard

N Material Replacement Summary
Model 1 Model 2
Material in system Werowhite Werowhite
Cartridges in drawer WeroClear WeroClear
<" Stratasys

Figure 6-14: Material Replacement Summary screen

After reviewing this screen, click Next and continue with step 8.

the Compartment Selection screen appears.

If the replacement cartridges are not loaded in the materials drawer,

Material Replacement Wizard

Compartment Selection

[ M1 compartment
[ M2 compartment

[ More...

-/ Stratasys

Figure 6-15: Compartment Selection screen

6. Select the cartridge(s) you want to replace, and click Next.
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7. From the drop-down menu, choose the material you want to install,
and click Next.

Material Replacement Wizard

-/ Stratasys

Material Selection

Select material type for Model compantmentis):

(8] hite v

’ X Qancel] ’{Erevious” Mext ]

Figure 6-16: Material Selection screen

license.

%( The Model materials available for selection depend on your printer type and

8. In the Flushing Options screen, choose the appropriate cycle for the
Model material you want to install.

Material Replacement Wizard Pz|

Flushing Options

Selectthe flushing cycle required:

() Economy [approx. 25 minutes)

(®) High-performance [appros. B0 minutes)

’ X Qancel] ’{Erevious” Mext g ]

Figure 6-17: Flushing Options screen

Economy. During this cycle, which takes about 25 minutes, the
pump purges the Model material from the print block, then flushes
the system with the new material.

Since traces of the previous material may be present in the first
models printed with the new material, this cycle is usually
acceptable when replacing a light-colored Model material with a
darker material (such as VeroBlack™), or if the exact color of the
printed models is unimportant. However, this cycle ensures that
models will have the mechanical properties of the new material.

The amount of material flushed during this cycle is—
xt 65 grams (+ 10%) when replacing one cartridge

xt 110 grams (+ 10%) when replacing two cartridges
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* High-performance. During this cycle, which takes about 60 minutes,
the wizard cleans the feed tubes and print block more thoroughly,
compared to the Economy cycle, by flushing the system with more
material.

This cycle ensures that models will have the color (and the
mechanical properties) of the new material, when replacing a dark-
colored material (such as VeroBlack) with a lighter-colored material.

The amount of material flushed during this cycle is—
x 300 grams (+ 10%) when replacing one cartridge
x 450 grams (+ 10%) when replacing two cartridges

9. Click Next, and take note of the warning screen.

Material Replacement Wizard

Please Note:

Beyond this point. clicking Cancel will abort the wizard
and disahle printing.

Printing will be enabled anly after completion of this
wizard

- | Stratasys

I X Carcel I [-(EreviousJ l Hext ]

Figure 6-18: Material Replacement warning screen

models with the Objet printer. To perform the procedure at another time,
click Cancel. If you continue (by clicking Next) and you do not complete the
procedure, you must start the Material Replacement Wizard again before
producing models.

Q Once you start this procedure, you must complete it before you can produce

10. Click Next.

* If the replacement cartridges are already loaded in the materials
drawer, the wizard checks that there is sufficient material to
complete the procedure. Continue with step 13.

* If the replacement cartridges are not loaded in the materials drawer,
the wizard prompts you to remove the cartridge(s) from the
drawer. Continue with step 11.
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11. When prompted by the wizard screen, remove the material
cartridge(s). Confirm this in the wizard screen and click Next.

12.

13.

Material Replacement Wizard

©

-/ Stratasys

Remove Cartridge(s)

Confirm before continuing:

[ Cartridge removed from M1 compartment.

[ Cartridge removed from M2 compartment.

’ x Lancel ] |‘~( Erevious?J

Figure 6-19: Remove Cartridge confirmation screen

When prompted, load the new cartridge(s) and close the drawer.
Confirm this in the wizard screen and click Next.

The wizard identifies the cartridge(s) and verifies that there is sufficient
material to complete the procedure.

After checking the amount of material in the cartridges, the wizard
proceeds as follows:

* If the amount of material is insufficient for completing the
procedure, the wizard prompts you to replace the cartridge(s).

Material Replacement Wizard

O

-/ Stratasys

Replace Material Cartridge(s)

The armount of material is insufficient for
completing this wizard. Replace and confirm:

[ Cartridge replaced in M1 compartment.

[] The materials drawer is clozed.

Figure 6-20: Prompt to replace cartridge due to insufficient material

Replace the required cartridge(s). Confirm this in the wizard screen

and click Next.
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* If the amount of material is sufficient for completing the procedure,
the printer purges the current material from the system, then
flushes the system and fills the print heads with the new material.

Material Replacement Wizard

O Material Replacement in Progress

aﬁ This process will take approximately 25 minutes.

- Stratasys

Figure 6-21: Material replacement: filling heads with new material

14. Click Done to close the wizard.

The printer-control application is automatically updated, and the
interface displays the new material(s). The Objet Studio application (on
the printer-server computer) is also updated and displays the new
material(s).

15. Inspect the area around the purge unit and clean it, if necessary.

CAUTION: Dispose of all material cartridges in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling. If this is done, protect the person handling
the cartridges from direct exposure to uncured resins.

DOC-34015 Rev. B 6-17



Operating & Maintaining the Objet30 3D Printer

Keeping the Printer in Idle Mode

6-18
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Between printing jobs, the Objet30 printer can be kept on for up to one
week. If the printer will not be used for more than a week, use the
Shutdown Wizard to automatically perform the procedures that must be
done before turning off the printer (see “Shutting Down the Printer,”
below).

When the printer stops producing models, the printer software
automatically reduces the temperature of the print heads as follows:

Time after printing Mode Change in heating of print heads
first 15 minutes Standby 1 none

next 5 minutes Standby 2 heating reduced (to room temp.)
after 20 minutes Idle heating stopped

Note: The printer mode is indicated in the green field on the left of the
interface (see figures 6-3, 6-7 and 6-8 on pages 3, 8 and 9).

If, after printing a job, you know that the printer will not be used for 20
minutes or more, you can immediately turn off the heating of the print
heads by putting the printer into Idle mode.

To put the printer into Idle mode:

» From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Objet printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this
mode—uwith the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown Wizard (see below).
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Shutting Down the Printer

W=

Shutdown
Wizard

DOC-34015 Rev. B

You only need to shut down the Objet printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode.

The Shutdown process flushes printing materials from printer components.
To avoid flushing out valuable material, make sure to print models at least
once a week. Many printer operators use this opportunity to print customer
samples or test models.

To properly shut down, the printer needs to perform several processes. Do
not attempt to shut down the printer by simply closing the computer
interface (the printer-control application), and never disconnect power to
the printer before completing the Shutdown Wizard.

¢ Shutdown for Less Than One Week

Before shutting down the printer or the printer computer for less than
one week, run the Shutdown Wizard. This wizard clears the print heads
of printing materials before shutdown.

¢ Shutdown for One Week or More

Before shutting down the printer or the printer computer for one week
or more, first run the Material Flush/Fill Wizard. This wizard replaces
printing materials in the print block with cleaning fluid.

Note: After preparing the printer with the Material Flush/Fill Wizard, you
must run it again before printing models, this time to replace the cleaning
fluid in the print block with printing materials.)

To run the Shutdown Wizard:

1. Select Shutdown Wizard from the Options menu, or press F8.

Shutdown wizard

i Shutdown wizard
| - A -l Use this wizard for shutdown of up to a week.
‘' Farlonger, first run the Material Flush/Fill Wizard.

(%) Run wizard marually.

() Run wizard unattended.

! Stratasys

Figure 6-22: Shutdown Wizard, opening screen
2. Select Run wizard unattended, unless you want more control over the
shutdown process.

Note: If you select Run wizard unattended, the wizard automatically turns
off the printer computer at the end of the process.

3. Click Next.

The options in the following screens are enabled only if you selected
Run wizard manually in the opening wizard screen.
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4. In the next screen, indicate whether or not the tray is empty and click

Next.
/—\ Shutdown wizard
( /\ )| Flease verify thatthe tray is empty.

w () Tray is emply

(&) Trap is full [choosing this option will move tray down)

</ stratasys

Figure 6-23: Tray status screen

The shutdown procedure begins.

Shutdown wizard

G . Shutdown Sequence

\ Q Clearing heads..
— W

-/ stratasys

Figure 6-24: Shutdown progress screen

The shutdown procedure may take up to 10 minutes while the
following tasks are performed:

a. The print block returns to its starting point on all axes.

b. The print heads are heated.

c. The print heads are cleared of any remaining material.

After these tasks are completed, the final wizard screen appears, in
which you choose whether or not to shut down the computer in the
Objet printer at this time.

Shutdown wizard

3 Computer Shutdown
i Do you want to shutdown the computer?
1___’.) @) Ve
' No
<" stratasys
>

Figure 6-25: Computer Shutdown confirmation screen
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5. When completely shutting down the Objet printer and turning the
power off, select Yes and click Next.

6. After the printer computer shuts down, turn off the main power switch
at the back of the printer (see figure 6-2 on page 2).

Material Use this wizard to prepare the printer for a shutdown of more than one
Flush/Fill week, and to restore the printer to working condition.
Wizard .

To prepare the printer for an extended shutdown, the wizard drains
printing materials from the print heads, then flushes the system with
cleaning fluid. This process takes about 60 minutes.

For this procedure, you need to load four (4) cleaning-fluid cartridges in
the materials drawer.

* To restore the printer to working condition, the wizard fills the system
with printing materials. This process takes about 30 minutes.

For this procedure, you need to load two (2) cartridges of Model
material and two (2) cartridges of Support material.

To run the Material Flush/Fill Wizard:
1. Start Material Flush/Fill Wizard from the Options menu.

2. In the opening screen, click Next.

: Select Action

(%) Drain materialz and fush system with cleaning fuid,

O Fill system with printing materials.

- Stratasys

’ X Qancel] ’%Erevious” Mext g ]

Figure 6-26: Wizard procedure selection

3. Select the required procedure, and click Next.

Note: Before continuing, make sure the required cartridges of material are
available for the procedure selected.
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Material FlushJFill Wizard

Prepare the printer

Confirm before continuing:

[] 4 cleaning cartridges are loaded.
[ Each cartridge weighs at least 300 gr.
[ The drawer is clozed.

-/ Stratasys

’ x Lancel ] ’{Erevious]

Figure 6-27: Cartridge confirmation screen—before flushing

Material FlushJFill Wizard

p, Prepare the printer

| G | Confirm before continuing:
J-'
\ ﬁ f [] 2 of same Material cartridges are lnaded.

[ 2 Support cartridges are loaded.
[ Each cartridge weighs at least 240 gr.
[ The drawer is clozed.

-/ Stratasys

’ x Lancel ] ’{Erevious]

Figure 6-28: Cartridge confirmation screen—before filling

4. Load the required cartridges, close the drawer, and confirm this in the
wizard screen.

In the next wizard screen, confirm that the printer cover is closed, and

click Next.

The wizard runs the material-flushing cycles.

Material FlushJFill Wizard

/

o

Emptying block... {Cycle 1 of 25)

-/ Stratasys

Figure 6-29: Flushing cycles in progress
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6. If cleaning-fluid cartridges are loaded in the printer, the wizard
prompts you to remove them. Confirm this in the wizard screen, and
click Next.

G . Wizard Completed

-/ Stratasys

Figure 6-30: Final wizard screen

you should close the printer-control application and Windows, and then turn

After preparing the printer for an extended shutdown period with this wizard,
'\ off the printer.
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Maintaining the Printer

Routine
Maintenance
Schedule

6-24

The performance of routine maintenance tasks is essential for getting
satisfactory results from Objet 3D printers. Perform the tasks at specified
intervals for optimum performance.

Frequency Task For More Information
After every print job Clean the print heads See “Cleaning the Print
and the roller surface. Heads” on page 6-25.
Clean the build tray and
the surrounding area.
Weekly Perform the Pattern test. | See “Pattern Test” on
page 6-27.
Weekly Clean and inspect the See “Cleaning and
wiper. Replacing the Wiper”
on page 6-29.

Weekly —when printing | Calibrate the UV See “Testing and
with MED610 intensity. Calibrating the UV
Lamp” on page 6-56.
Weekly Restart the printer
computer and the
server computer.
Every 300 hours of Calibrate the UV See “Testing and
printing intensity. Calibrating the UV
Lamp” on page 6-56.
Every 300 hours of Optimize the print See “Optimizing
printing heads. (Calibrating) Print
Heads” on page 39.
Monthly, and after Check the alignment of | See “Aligning the Print
replacing print heads the print heads. Heads” on page 6-35.
Every 500 hours of Calibrate the load cells. | See “Calibrating the
printing, or once every Load Cells” on
six months page 6-59.

Every 1000 hours of
printing, or once a year

Preventive maintenance.

Preventive maintenance is
performed alternately, by
the customer and an
authorized service
engineer.

Contact your Stratasys
support center.

Once a year

Inspect the activated-
carbon odor filter, and
replace if necessary.

See “Replacing the
Odor Filter” on
page 6-61.
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Cleaning the Periodic inspection and cleaning of the orifice plates on the bottom of the
Print Heads print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the printer to
enable you to perform it. To maintain the Objet30 printer in optimum
condition, clean the print heads after every print job, when you remove the
model from the build tray. This procedure takes about 20 minutes.
To clean the print heads:
1. Prepare—
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
* disposable cleaning gloves
* the supplied cleaning cloth or equivalent
* amirror

2. Start the Head Cleaning Wizard from the Options menu (see
figure 6-38 on page 29).

3. Follow the instructions on the wizard screens, and select the
confirmation check boxes.

Head Cleaning Wizard

Head Cleaning Wizard

Check that the tray is empty and close the cover.

[ Tray iz Empty.
[ Cover is closed.

</ stratasys

Figure 6-31: Head cleaning procedure—wizard screen
4. Click Next.

The printer prepares for you to clean the print heads.
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5. When the following screen appears, open the cover.

Head Cleaning Wizard

Clean Printer Components

SSS Confirm before continuing:
e [~ The print heads are clean.

[~ The roller iz clean.

- Stratasys

? Help | x Lancel | Ereviousl st

Figure 6-32: Head cleaning wizard—steps 5-10

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

Place the mirror on the build tray.
Put on the gloves.
Soak the cleaning cloth with alcohol.

o ® N

Clean the orifice plates, with a back-and-forth motion (see figure 6-33).
Use the mirror to make sure that you have removed all of the residue
material.

Figure 6-33: Cleaning the heads

Use this opportunity to clean the entire roller surface, by rotating the roller,
and clean the UV lamp.

10. When you have finished cleaning, select the confirmation check box in
the wizard screen (see figure 6-32) and click Next.

11. Remove the cleaning materials from the printer and close the cover.

12. Select the confirmation check boxes in the wizard screen and click
Next.
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The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Head Cleaning Wizard

Wizard completed

' stratasys

Figure 6-34: Head-cleaning wizard—final screen
13. Click Done to close the wizard.
Pattern Test The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the

print heads. Make sure, therefore, that you perform this test weekly, and
whenever you suspect a printing problem.

To perform the pattern test:
1. Make sure that the build tray is empty.

2. Prepare a sheet of pink paper, approximately 21 x 14 centimeters in
size (8.5 x 5.5 inches) —half of the standard A-4 or Letter size.

3. In the printer, tape the pink paper to the center of the build tray.
Press F3, or open the Options menu and select Pattern Test.

9 Perform Pattern Test?
\_‘

Figure 6-35: Pattern Test confirmation

5. In the following dialog box, click OK to confirm that the paper is in
place on the build tray.

Information S|

S —

\'] The build tray is clear and the pattern test paper is in
" place.

Figure 6-36: Confirmation before printing on test paper
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Improving
Print Quality

6-28

The printer prints a series of lines on the test paper (see next figure).

Lines printed by Lines printed by
Support-material - g Model-material
print head print head

Figure 6-37: Sample Pattern Test

Carefully inspect the test paper to see if there are missing lines.

Too many missing lines, especially if they are in the same area,
indicates that the quality of printing when producing models will be
poor. If this is the case, see “Improving Print Quality,” below.

Note: Acceptable model quality is subjective, and depends on the type
and scale (size) of the models produced. As a rule, however, if two
consecutive lines are missing, or if there are more than 10 lines missing in
either column, the model quality is usually unacceptable.

If you suspect that print quality is poor, perform the pattern test (see
“Pattern Test”). If the results are poor, use the following procedure to
improve print quality.

If the results of the last pattern test are poor:

1.
2.

3.
4.

From the Options menu, select Purge Sequence, or press F4.
In the confirmation dialog box, click Yes.

The print heads are purged of Model and Support material, and the
wiper removes excess material from them.

Repeat the purge sequence.
Perform the pattern test.

If the results of the pattern test are still poor:

1.

2.
3.

Manually clean the print heads (see “Cleaning the Print Heads” on
page 6-25).

Perform the purge sequence.

Perform the pattern test.

If the results of the pattern test are still poor:

1.

2.

Carefully clean the print heads again, making sure there is no residue
left on them.

Perform the purge sequence.
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3. Perform the pattern test.

If the results of the pattern test are still poor:
» Optimize the print heads and replace faulty print heads, if necessary
(see “Optimizing (Calibrating) Print Heads” on page 6-39).

Cleaning and A rubber wiper removes excess material from the print heads after the
Replacing the  purge sequence. This is done automatically before each print job, and
Wiper performed manually during maintenance tasks. You should clean the

wiper and surrounding area at least once a week. If the wiper is damaged
or worn, replace it.

To inspect and clean the wiper:
1. Prepare—
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
* disposable cleaning gloves
* the supplied cleaning cloth or equivalent
® aspare wiper
* an M2.5 Allen key
2. Start the Wiper Cleaning Wizard from the Options menu.

r File Options Help
o
-:;: .-’Stratasys Go to Tray Upper Position F5
: Goto Service Position F&

Wipe F7
— Execute Purge Sequence  F4

Pattern Test F3

i Heads Cleaning !
| Maintenance Counters... Head Optimization |

§ |
| Collect Service Data F2 Load el Callbration |

| Shutdown Wizard Material FlushyFill Wizard
| Material Replacement
Relnitiate !
U Calibration Wizard
placement

| @BJET ( L0 FullCure705 ',‘

FullCure705 E—
I 620 gr

_VeroWhite

640 gr
| om—

Figure 6-38: Starting the Wiper Cleaning Wizard

3. In the opening wizard screen, click Next.
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4. Make sure that the build tray is empty, and close the printer cover.

Confirm this in the wizard screen and click Next.

Wiper Cleaning Wizard

Wiper Cleaning Wizard

> Confirm before continuing:

[ Tray is empty

[ Cover is closed
i)
(o
1 -
\u = I"'---.

Figure 6-39: Wiper Cleaning procedure—step 4

5. When the following screen appears, open the cover.

Wiper Cleaning Wizard

Is Wiper clean ?

> Open the cover and clean the wiper.

['wiper clean

Figure 6-40: Wiper Cleaning Wizard during steps 69

6. Put on the cleaning gloves.

Using a generous amount of alcohol on the cleaning cloth, remove any
material remaining on the wiper and the surrounding area.

6-30
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8. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. With the M3 Allen key, loosen (but do not remove) the screw
securing the wiper.

Figure 7: Wiper and excess-material drain

b. Grasp the wiper unit and remove it.
Note: Do not remove the grease.

c. Insert the new wiper, making sure that it is level, and tighten the
securing screw.

9. In the wizard screen (see figure 6-40), confirm that the wiper blade is
clean, and click Next.

10. Remove all tools and cleaning materials from the printer, and close the
cover.

11. Confirm this in the wizard screen, and click Next.

Wiper Cleaning Wizard

Wiper Cleaning Wizard

- Check if the tray is empty and close the cover.

[ Tray is empty

[ Cover is closed
i)
(o
1 -
\u = I"'---.

Figure 6-41: Confirmation screen

12. Click Done to close the wizard.
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Cleaning and Normally, you do not have to inspect and clean the roller waste collector.
Replacing the  This is done by a customer-support engineer during regular maintenance
Roller Waste visits. Occasionally, however, a blockage or damaged scraper may cause
Collector material leakage on the build tray. If this happens, remove the roller waste
collector to inspect it.
To remove the roller waste collector:
1. Start the Head Cleaning Wizard from the Options menu (see figure 6-38
on page 29).
This wizard prepares the printer for removing the roller waste
collector.

2.  When the following screen appears, confirm that the tray is empty and
that the printer cover is closed, then click Next.

Head Cleaning Wizard

Head Cleaning Wizard

Check thatthe tray is empty and close the cover.

[ Tray is Empty.
[ Cover is closed.

-/ Stratasys

Figure 6-42: Wizard confirmation screen

The print block moves to the center of build tray, and the tray lowers.
3.  When the following screen appears, open the cover.

Head Cleaning Wizard

Clean Printer Components

Confirm before continuing:

[~ The print heads are clean.

[~ The roller iz clean.

-/ Stratasys

? Help | x Lancel | Ereviousl st |

Figure 6-43: Wizard screen that appears when you can begin the procedure

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

4. Put on protective gloves.
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5. Loosen the two side screws securing the UV lamp assembly, and place
the assembly on top of the print block.

Securing
screws

Figure 6-44: UV-lamp-assembly securing screws

6. Pull out the drain-tube release mechanism to raise the tubes out of the
waste collector (see figure below).

Figure 6-45: Freeing the drain tubes from the waste collector
Important: Pull out the release mechanism completely.

7. Support the roller waste collector with your hand under it, and use a
3 mm Allen key to loosen the screws.

Figure 6-46: Roller-waste-collector screws

8. Pull out the roller waste collector, taking care not to touch or damage
the scraper.

& WARNING: The scraper is very sharp! Proceed with caution.

Waste channel
Scraper

Figure 6-47: Roller waste collector
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Inspect the roller waste collector.

* If the scraper is damaged, replace the entire roller-waste-collector
unit.

* If the scraper is not damaged, carefully remove any waste from the
waste channel, taking care not to damage the scraper. If necessary,
use IPA or ethanol to dissolve residue material in the waste channel
and on the scraper.

Note: The waste collected in this unit contains uncured resin. Dispose of it
in accordance with applicable environmental regulations.

To install the roller waste collector:

Carefully insert the roller-waste-collector unit.

2. Secure the unit evenly, by alternately tightening the screws.

3. Return the drain-tube release mechanism to its original position by

pushing it in all the way:.

Figure 6-48: Returning the drain tubes from to the waste collector

Move the print block back to the middle of the printer.

Replace the UV lamp assembly in the printer, making sure that the
cable fits into the slot together with the side securing screw.

Figure 6-49: UV-lamp cable in place after securing the assembly

Remove all tools from the printer, and close the cover.

In the wizard screen, click Cancel to return the build tray to its former
position.
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Aligning the
Print Heads

DOC-34015 Rev. B

You should check the alignment of the print heads—

* once a month

* after replacing one or more heads

* if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see “Cleaning the Print Heads” on
page 6-25)

The head-alignment procedure takes about 20 minutes.

To check the alignment of the print heads:

1. Prepare—

* atransparency sheet, at least 10.5 x 13 centimeters in size (4.5 x 5.5
inches)—about one-quarter of the standard A-4 or Letter size

* any type of sticky tape, to fasten the transparency sheet to the build
tray

2. Start the Head Alignment Wizard from the Options menu (see
figure 6-38 on page 29).

3. Click Next to begin, and close the cover.

In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.

Head Alignment Wizard

Close the Door

[ Do is cloged

</ stratasys

(o] < >

Figure 6-50: Door is closed confirmation screen

5. When instructed to do so, place the transparency on the build tray —
near the left and rear edges of the tray, as shown in the following
figure.

.

Figure 6-51: Positioning the transparency on the build tray

6. Make sure that the transparency sheet is lying flat, and tape it to the
tray.
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7. In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.

8.  When the following screen appears, remove the transparency.

Head Alignment Wizard

. Remove transparency from tray
— \d
[ Transparency removed
| Stratasys

Figure 6-52: Head Alignment Wizard—steps 8-10

The transparency sheet is printed with sets of vertical lines in two rows,
each showing the results from a different print head.

1 2 34 5 6 7 8 910 M1 1213 14 15
ARRNRARRRRRRRR*
| |5

Figure 6-53: Sample head-alignment test
* The top row was printed by the head used for applying Model
material when producing models.

Model head

Support head

* The bottom row was printed by the head used for applying Support
material.

9. Use a magnifying glass or loupe to inspect the transparency.

Optimum head alignment is shown when the two #8 lines, in the upper
and lower rows, are aligned, as in figure 6-53. In the example shown, no
change to the head alignment is necessary. If other lines in the set are

aligned, you need to change the alignment—in the next wizard screen.

10. In the wizard screen shown in figure 6-52, select the Transparency
removed check box, and click Next.
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11.

12.

13.

The first in a series of alignment screens appears.

Head Alignment Wizard

Bl or Support Head

ﬂ Aligned  ohoose the best printed line in the transparency
Off

12 3 4 56 7 89 1011 1213 14 15
000000 ®OOOOCOOO0

-/ stratasys

’ X Qancel] ’{Erevious” Mext ]

Figure 6-54: Head alignment screen

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows.

Note: Because the alignment of the middle lines is optimum, the number
“8" is selected, by default, in the wizard screen. This does not change the
head alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.

Click Next.

The following screen is displayed.

Head Alignment Wizard

Updating System Parameters

Do you want to update the system parameters for
the last calibration results?

® Yes
O No
</ Stratasys
’ XK Cancel ] ’{Erevious] ’ Mext ]

Figure 6-55: Update confirmation screen
Continue as follows:

* To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.

* To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

* If you do not want to make alignment changes in the printer at this
time, select No and click Next.
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14. In the following screen, you can choose to either repeat the head
alignment procedure or close the wizard.

* If the most closely aligned vertical lines for a print head were at
either extreme, choose Yes to run the Head Alignment Wizard
again, then click Next.

The transparency test will show if the heads are now properly
aligned, and —if not—the wizard will allow you to “fine tune” the
alignment.

* If the vertical lines for the print heads were not aligned at either
extreme, choose No to close the wizard, then click Next.

Head Alignment Wizard

Do you want to repeat the test?

(3 ‘ez - Print anather tranzparency

(O Mo - | want to end of “Wizard

-/ Stratasys

I X Qancel‘ I{Erevious” Mext ‘

Figure 6-56: Repeat head alignment option

Wizard after replacing print heads, the printer application closes and re-

If the Head Alignment Wizard was opened from the Head Optimization
i \ opens when you click Done in the final wizard screen.
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Optimizing
(Calibrating)
Print Heads
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The condition of the print heads directly affects the quality of printed
models. To maintain optimum printing, test the print heads, and calibrate
them to the best working configuration possible by running the Head
Optimization Wizard. This procedure takes about one hour to complete.

During the optimization process, samples are printed on the build tray.
After carefully inspecting and weighing each of them, you enter data in the
wizard. The wizard uses this data to optimize the heads.

If, during the optimization process, the wizard determines that a print head
is faulty —or that it is negatively affecting layer uniformity with the current
head configuration —the wizard instructs you to replace it. If this happens,
you can continue the wizard to replace the print head, or abort the wizard,
to replace the head at another time. This procedure takes about 2.5 hours
more to complete.

Run the Head Optimization Wizard every 300 hours of printing or whenever
the condition of print heads is negatively affecting the quality of printed
models, or if you suspect that there is a problem with one or more of the
print heads.

To test and calibrate the print heads:
1. Prepare—
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)

* disposable cleaning gloves (any clean, powder-free protective
gloves)

* the supplied cleaning cloth or equivalent

* amirror

* the Missing Nozzles ruler

* the scale supplied for use in the Weight Test

Note: Ensure that the scale is calibrated and charged before beginning
this procedure.

2. Start the Head Optimization Wizard from the Options menu.

{ File Options Help
$ ,Stratasys Go to Tray Upper Position FS
<l (Goto Service Position F&
Wipe F7?

Execute Purge Sequence  F4

Pattern Test

1|| |

Head aAlignment

Buil: In Tests... Chrl+-alt+E Heads Cleaning

Head Optimization
Load Cell Calibration
Material Flush/Fill Wizard

Shutdown Wizard Fa Material Replacement
=== Relnitiate

Maintenance Counters...
Collect Service Data F2

LI Calibration Wizard
LY Lamp Replacement

@B_]ET O @ O . Wiper Cleaning i

Figure 6-57: Starting the Head Optimization Wizard

3. In the opening wizard screen, click Next to begin.

4. Close the printer cover, and confirm this in the wizard screen.
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5. In the following screen, make sure Optimize all print heads is selected,
and click Next.

Select Action

' Optimize all print heads.

" Replace faulty heads and optimize all heads.

-/ Stratasys

? Help | x Lancel | {Ereviousl Mext |

Figure 6-58: Procedure selection screen

The print block moves into position for cleaning and inspecting the
print heads.

6. When the following screen appears, clean the print heads.

Head Optimization Wizard

Clean Print Heads

Confirm before continuing:

[~ The print heads are clean.

-/ Stratasys

Brevious st

Figure 6-59: Clean print heads screen

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

Place the mirror on the build tray.
Put on the cleaning gloves.
Soak the cleaning cloth with alcohol.
10. Clean the orifice plates, with a back-and-forth motion.

Use the mirror to make sure that you have removed all of the residue
material.
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Figure 6-60: Cleaning the print heads

11. When the print heads are clean, select the confirmation check box in
the wizard screen and click Next.

12. Remove the cleaning materials and the mirror from the printer, and
close the cover.

13. Confirm the items listed in the next screen, and click Next.
Head Optimization Wizard E

[\ Printing Preparations

=k Confirm before continuing:

[ The tray iz empty.,
[ The cover iz closed.

]

|:| The weight sample scale is calibrated.

<" stratasys

’ x Lancel ] ’{ Erevious]

Figure 6-61: Confirmation screen

Inaccurate readings may result in print heads that are not optimized for

Make sure that the scale for weighing the printed samples is calibrated.
i \ quality printing, or a false indication that a head needs to be replaced.
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Head Optimization Wizard

oy

Reinitiating and Printing
Weight Test

This step can take up to 80 minutes.

| 1%

-/ Stratasys

Figure 6-62: Printing Weight Test

14. Select the confirmation check box in the wizard screen and click Next.

The printer prepares itself for printing (by running the reinitaite
process). Then, 6 or 12 samples are printed on the build tray, depending

on the printer model. This can take up to 80 minutes.

the printed samples.

Head Optimization Wizard

—— Weight Test Data Entry
I" | E;: I l Build Tray Map
L R ":l%‘m: of M 5 M 5 M s
~ A~ =
~ ] ©)
Sample
weight
[grams]
Enter data for marked sample (+) in the fields on the left,
=" Stratasys
’ Edit data ] ’ x Qancel]

Figure 6-63: Data-entry screen for some Objet30 printers

Head Optimization Wizard

—— Weight Test Data Entry
I" | E;: I l Build Tray Map
L m“s‘i'ng M s M s M s
-'.\_‘ - Mozzles
Sampl
Vg
[grams]
Enter data for marked sample (+) in the fields on the left,
=" Stratasys
’ Edit data ] ’ x Qancel]

Figure 6-64: Data-entry screen for Objet30 Pro printers

15. When the following screen appears, open the printer cover to inspect

S

6-42

The layout of the data entry screen matches the printed samples on the
build tray. You enter the data for the sample indicated by € in the screen.
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16. Using the Missing Nozzles ruler, determine the number of clogged
(“missing”) nozzles.

=ty

p
3
4
5
6
7
8
9

Figure 6-65: Missing Nozzles ruler

Clogged nozzles are seen in Weight Test samples as missing rows of
printed material.

a. Place the alignment line on the right side of the ruler next to the
bottom of the sample, as shown.

R,

Figure 6-66: Aligning the ruler to the bottom of the sample

b. Check if there is a space below the line on the ruler marked
“Maximum height of sample.”
A space below this line indicates missing nozzles at the extremes of
the printed sample. The numbers indicate how many printed rows
(nozzles) are missing. Remember this number.

Maximum height of sampie

Figure 6-67: Measuring missing nozzles at the extremes of the sample

Note: Because you align the ruler to the bottom of the printed sample,
missing nozzles at the bottom edge are measured at the top of the ruler.
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c. Check if there are gaps in the printed sample by matching the gap in

the sample with a line on the Missing Nozzles ruler. The number on
the ruler next to the line indicates the number of missing
rows/nozzles.

Ruler

Missing row\

Printed sample—]

Figure 6-68: Measuring a missing row in a printed sample
In the example above, the number of missing nozzles is two (2).

. Enter the total number of missing rows in the wizard screen (in the
“missing nozzles” field).

Note: During this procedure, the roller does not smooth the surface of
the printed samples. Do not mistake the visible lines in the sample for
missing material.

Figure 6-69: Printed sample for Head Optimization

17. Carefully remove the sample, weigh it, and enter the weight in the

18.

wizard screen.

Be sure to remove and weigh the entire sample, even if it breaks into
several pieces.

After entering the number of missing nozzles and the weight of the
sample, click Apply or press Enter.

The data-entry-indicator € moves to the next position.

19. Enter the data for all printed samples.

%( To change an entry, click Edit Data, enter the correct data, and click Save.

6-44

DOC-34015 Rev. B



Objet30 User Guide

20. When you have entered the data for all printed samples, click Next.

The wizard uses the data collected to analyze the condition of the print
heads, and optimizes them so they print models with a uniform layer of
material.

* If the heads are in satisfactory condition, the following wizard
screen appears.!

Head Optimization Wizard

N Print-head Optimization

Completed
M The wizard has optimized the print head parameters.

You need to restart the printer application to print with the
new parameters.

Click 'Done' to close the wizard and restart the printer
application.

-/ Stratasys

5T Cancel | Ereviousl " Dore I

Figure 6-70: Final wizard screen, after optimizing print heads

Note: To apply the optimized settings to the print heads, the printer
application must be restarted. When you click Done, the application
closes and re-opens.

* If the wizard determines that a print head is faulty —or that it is
negatively affecting model quality with the current head
configuration —the wizard instructs you to replace it. In this case,
the following screen appears.

Weight Test Results

Model print head(s) still not functioning properly.
It is recommended to replace the print head(s).

__.'/-- --\‘\._

' Replace faulty head(s).
Aot wizard.

-/ Stratasys

? Help | X Cancel | Previous | [ N

Figure 6-71: Defective print heads found

1. However, after optimizing print heads following their replacement, a
screen appears enabling you to continue by running the Head Alignment
Wizard (see page 35). This is necessary before printing models.

If you choose not to align the heads at this time, the printer application
closes and re-opens when you click Done.
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To replace print heads, you need these tools and materials:
* replacement print head(s)
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)

* disposable cleaning gloves (supplied with the print head; or use
any clean, powder-free protective gloves)

* asupplied cleaning cloth or equivalent

* the scale supplied for use in the Head Optimization Wizard
(Weight Test)

* the Missing Nozzles ruler

21. Choose Replace faulty head(s) if you are prepared to replace the print
heads now.

or—

Choose Abort wizard if you want to replace the print heads at another
time.

Replace print heads only after consulting with a Stratasys-authorized
customer-support engineer.

If you are replacing the print heads now, the wizard guides you through the
procedure when you click Next. Continue with “Preparing the Print Block”

on page 48.
Replacing The condition of the print heads directly affects the quality of printed
Print Heads models. You may need to replace a print head if one or more of the

following symptoms occurs:

* The Head Optimization Wizard determines that a print head is
defective. (See “Optimizing (Calibrating) Print Heads” on page 39.)

* There are noticeable grooves in the surface of printed models.

* Visual inspection of the head reveals that its surface is damaged —
peeling or bubbles in the nozzle area.

* The printer interface displays a warning or malfunction message
relating to a print head —

O Head Heater temperature timeout
O Head Heater thermistor open
O Head Heater thermistor short

Replace print heads only after consulting with an authorized customer-
support engineer.
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The Head Optimization Wizard guides you through the procedure of
replacing a print head, and adjusts printer components to enable you to
perform it. Only replace a print head with the aid of the wizard. The entire
procedure takes about 2.5 hours, and consists of the following phases:

A. Identifying the head(s) needing replacement.

This is normally done by the Head Optimization Wizard. Otherwise,
evidence of physical damage to the head surface or a malfunction
message indicates which head needs replacing.

=

Preparing the print block for head replacement.

This is done automatically when you run the Wizard.
Removing the defective print head.

Installing a new print head.

Optimizing the print heads (done automatically by the wizard).

MmO 0

Performing head alignment.

To replace a print head:
1. Prepare—
* replacement print head(s)
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)

* disposable cleaning gloves (supplied with the print head; or use
any clean, powder-free protective gloves)

* asupplied cleaning cloth or equivalent

* the scale supplied for use in the Head Optimization Wizard
(Weight Test)

* the Missing Nozzles Ruler

Note: Make sure that you have these items and that the scale is calibrated
and charged before performing the head-replacement procedure.

2. Start the Head Optimization Wizard from the Options menu (see
figure 6-38 on page 29).

In the opening wizard screen, click Next to begin.

4. In the following screen, select Replace faulty heads, and click Next.

Head Optimization Wizard

Select the procedure required

() Optimize all print heads.

(%) Replace faulty heads and optimize all heads.

<" stratasys

’ X Qancel] ’{Erevious” Mext g ]

Figure 6-72: Procedure selection screen
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Preparing the 5. Select the print head(s) needing replacement, and click Next.

Print Block

Head Optimization Wizard

Select Heads to Replace

Support Model

O O

-/ Stratasys

’ x Lancel ] ’{Erevious]

Figure 6-73: Head selection screen

The printer heats and empties the print block, and prepares the printer.

Head Optimization Wizard

~

Preparing for Head Replacement

y 4 L%
Ko 'i
\ Q/ﬁi This step can take up to 50 min.

-/ Stratasys

| X Cancel

Figure 6-74: Printer preparation progress screen

The following screen appears when the printer is ready for you to

replace print heads.
Print Head Replacement

The printer is ready foryou to replace print heads.
Click 'Next' to continue.

-/ Stratasys

Figure 6-75: Printer ready for head replacement
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7. Put on the protective gloves and open the printer cover.
Note: The printer disconnects power to the heads for your safety.

Head Optimization Wizard

Replace Print Heads

Fefer to the instructions in the head replacement
kit, or click 'Help' below. Then canfirm:

[ Support head replaced.

<V stratasys

(Xoe] =

Figure 6-76: Print-head replacement confirmation

Removing the
Defective Head

% To replace the Model print head, you must first remove the Support print
head.

Removing the Support Print Head

f A. Put on protective gloves. h 2 Remove the print block cover. )
B. Remove screws B.

C. Loosen screw C.

A. Remove the Support print head card. ) ; 4 While holding the print head, press down )
B. Loosen the print head thumb screws. on the thumb screws and remove it.
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Make sure you remove the two O-ring Protect the print head from UV light if
seals along with the print head. you plan to re-install it.

Discard the print head
in accordance with
local regulations.

) I 2,

» If you do not need to replace the Model print head, continue with
“Installing the Support Print Head” on page 6-52.

Removing the Model Print Head

B. Loosen the print head thumb screws.

' 1 A. Remove the Model print head card. ) 2 While holding the print head, press down )
on the thumb screws and remove it.

f Make sure you remove the two O-ring
3 seals along with the print head.

Discard the print head
in accordance with
local regulations.
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Installing the Model Print Head

» When re-installing a used print head, always replace the O-ring seals
with new seals.

i Make sure the O-ring seals )
1 are installed on the print head.

— _/

: With the print head in the positioning jig, 1
align it as shown.

o /

3 A. Push jig upwards where marked “Push Firs:n
B. Push jig upwards where marked “Front.”

Tighten the print head thumb screws.

H ("
J
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-

Press down firmly on the Model print )
5 head card to attach it to the print block.

7
.. )

Push on the tab and then pull the jig

downwards to remove it.
\\ 3

\_ Remove =" )

Installing the Support Print Head

» When re-installing a used print head, always replace the O-ring seals

with new seals.

i Make sure the O-ring seals
1 are installed on the print head.

ﬁ‘
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2 With the print head in the positioning jig, )

align it as shown.

/

A. Push jig upwards where marked “Push First.
B. Push jig upwards where marked “Front.”

. /
~
4 Tighten the print head thumb screws.
N /
Press down firmly on the Support print
5 head card to attach it to the print block.
L
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G Push on the tab and then pull the jig )
T Q'_'I& L @,

Removel
-
Install the print block cover.

J \

.
- ™
A. Insert and tighten screws A.
B. Tighten screw B.
q I P

8. In the Replace print heads screen (see figure 6-76 on page 49), select the
check box to confirm that you have replaced the head(s), and click
Next.
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9. Confirm that the heads are level and even by selecting the check box in
the following wizard screen, and click Next.

Head Installation Check

Confirm before continuing:

[] The print heads are level and even.

-/ Stratasys

’ x Lancel ] |~( Previous |

Figure 6-77: Installation-check screen

10. In the next wizard screen, confirm that you have removed all tools and
objects from the printer and that the cover is closed.

Head Optimization Wizard

L. Printer Check

Q Canfirm befare cantinuing:
- The tray is emphy.

- The cover is closed.

-/ Stratasys

’ X Qancel] ’{Erevious” Mext = ]

Figure 6-78: Cleared-tray confirmation screen

The wizard continues by heating the heads, then filling and purging them.
If there are no installation problems, the Head Optimization procedure
begins, to calibrate the print heads to the best working configuration (see
“Optimizing (Calibrating) Print Heads” on page 6-39) After this procedure,
you should run the Head Alignment Wizard before printing models.

If installation problems are detected, the wizard alerts you and instructs
you how to continue (see “Installation Problems,” next).
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Installation
Problems

Testing and
Calibrating the

UV Lamp
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S

If the printer detects that there is a problem after you install print heads,
relevant warning screens appear.

* If the print head you installed is not new —that is, it was previously
removed from a printer —the following message appears.

<P Please note that Model head is & used one.
-
-

Press YES to continue,or MO to replaceit,
Mo

Figure 6-79: Used print head message

O To continue with the installation of this print head, click Yes.
O To remove this print head and install a new one, click No.

* If the printer software does not detect the replaced head, the following
warning screen appears.

Head Optimization Wizard

. Head Installation Failure
Flease reinsert heads: Support
[ Done
'_.’E
Stratasys

Figure 6-80: Incorrect-installation screen, showing which head(s) to re-insert
If this happens:

a. Re-insert the print-head driver card into its socket.

b. In the wizard screen, select the check box to confirm that you have
re-inserted the card, and click Next.

The effective UV radiation from the lamp used for curing models can
change over time. Too little UV curing can cause some of the printing
material to remain in a liquid state, on models, when printing has finished.
Test the lamp and calibrate its effective UV radiation after every 300 hours
of printing, or when you suspect that this is necessary, by running the UV
Calibration Wizard.

The wizard compares the measured radiation to the recommended
radiation level. When calibrating the lamp, the wizard attempts to adjust
the radiation level, if necessary.

* If the reading is within the acceptable range, the wizard continues.
* If further adjustment is necessary, the test is repeated.

* If the UV radiation is too low to be properly adjusted, the wizard
indicates that the lamp’s radiation for the printing mode is
unacceptable.

Before testing and calibrating the UV lamps, make sure the glass lens on
the UV lamp is clean. For easy access, run the Head Cleaning Wizard, and
use the special cleaning pad supplied in the accessories kit (Box 1).
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To test and calibrate UV lamp radiation:

1.

Start the UV Calibration Wizard from the Options menu (see figure 6-38
on page 6-29).

In the following screen, select UV Intensity Calibration to adjust the
lamp’s radiation level to the acceptable range.

U¥ Calibration Wizard

Select Action

O Y intensity test

(&) Y intensity calibration

" Stratasys
<

Figure 6-81: UV Test/Calibration selection

Make sure that the build tray is clear (empty). Confirm this in the
wizard screen and click Next.

U¥ Calibration Wizard

Internal Sensor Preparations

Confirm before continuing:

[] The intemal U sensor cover is open.

[] The intemal Uy sensor glass is clean.

" Stratasys

(Xoe] =

Figure 6-82: Printer preparation

4. Expose the UV sensor by sliding its cover to the right, and check that

DOC-34015 Rev. B

the glass is clean.

Figure 6-83: UV sensor exposed

If necessary, clean the glass over the UV sensor with a cleaning cloth
and alcohol (IPA).

Do not use the abrasive cleaning pad to clean the glass.
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When you click Next, the UV lamp powers up and stabilizes. (This takes
several minutes.) Then, the print block passes over the sensor and the
wizard compares the measured radiation to the recommended level.

UV Calibration Wizard

% -2

UV Intensity Measurement

I (- 150 s=c.)

"La mp stabilization

uv
(li— 3Cydes ‘

-/ Stratasys

Brevious | st |

Figure 6-84: UV measurement progress

If the UV level measured is not acceptable, the wizard calibrates the UV
lamp by adjusting the current supplied to it, and then tests it again.

When completed, the wizard displays the condition of the lamp, after
calibration.

UV Calibration Wizard
l

<" stratasys

UV Calibration Results

& 131.4% [130%)
108-3 117

Figure 6-85: Final condition of UV lamp—acceptable intensity level

U¥Y Calibration Wizard

l..

UV Calibration Results

$€ 46.2 % [130%]
113-> 238
*Replace lamp

</ Stratasys

Figure 6-86: Final condition of UV lamp—unacceptable intensity level
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Calibrating the
Load Cells
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6.

If the wizard cannot adjust the lamp to within the specified UV
intensity range, perform the following steps and run the wizard again
before replacing the lamp:

* Check that the UV-lamp glass is clean.

* Check that the UV sensor is completely uncovered and that the
protective glass is clean.

If the results are still unacceptable, contact customer support for further advice.

Click Next, close the UV sensor cover, and confirm this in the wizard
screen. Then click Next to complete the wizard.

UY Calbration Wizard

Wizard Completed

</ Stratasys

Figure 6-87: Final UV Calibration Wizard screen

Load cells are sensors that measure the weight of the printing cartridges

and the waste container in the printer. It is important that you periodically
check that the weight measurements are accurate, both for convenience and
to prevent unnecessary waste of printing materials. It is recommended that
you calibrate the load cells after 500 hours of printing, or every six months.

To calibrate load cells:

1.

Start the Load Cell Calibration Wizard from the Options menu (see
figure 6-38 on page 29).

Select one or more load cells that you want to calibrate, and click Next.

Load Cell Calibration Wizard

Load Cell Selection

\ G / [[] Calibrate Mode! load cel

L [ Calibrate Suppart load cell
[ Calibrate ‘W aste load cel

<" stratasys

Figure 6-88: Load cell selection

Remove the cartridge or container, as instructed by the wizard, and
close the materials drawer.

Important: Make sure that the materials drawer is closed
before continuing. Otherwise, calibration will be affected.
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4. Select the confirmation check box and click Next.

Load Cell Calibration Wizard

r Remove Left Model Cartridge

E
W I [ Model Left Cartridge removed

-/ Stratasys

’ x Lancel ] ’{Erevious]

Figure 6-89: Confirmation of cartridge removal

In the next wizard screen, observe the numbers and wait until the level
is relatively stable —two units above or below the average level shown.

Load Cell Calibration Wizard

Model Weight Stabilization

oy

Current Level 2578

[]'weight is stable
=" Stratasys

Figure 6-90: Level stabilization

Select the check box, and click Next.

If you need to calibrate more than one load cell, the next calibration
screen appears. Repeat steps 5 and 6 until all of the load cells are
calibrated.

Click Done in the final wizard screen.

Load Cell Calibration Wizard

Wizard Completed

L

Yerify the following befare finishing:
*The waste-container cover is in place.
*The drain tube is nat bent.

-/ Stratasys

Figure 6-91: Final wizard screen
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Replacing the
Odor Filter
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8. Replace the cartridges/container.

» When replacing the waste container, hold the waste bag with one hand
while connecting the waste tube. Otherwise, the bag will be twisted, and
the flow of waste will be restricted.

» Make sure to replace the metal cover over the waste container.
Operating the printer without the cover results in an inaccurate
measurement of the waste weight, which will cause waste to overflow
into the printer.

If the printer exhaust is not connected to an external ventilation system, a
built-in activated-carbon filter removes odors from printing materials. This
filter should be replaced regularly (as necessary) to keep your working
environment pleasant. This is normally done during the preventive-
maintenance service visit.

To replace the odor filter:

1. Locate the filter drawer at the rear of the printer and pull it open.

Odor filter drawer

Figure 6-92: Rear of the Objet30 printer
2. Remove the used filter. (You can push it out from underneath the
drawer.)

Figure 6-93: Odor filter in drawer

3. Insert a new filter and close the drawer.
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Replacing the  The UV lamp used for curing models has a long, but limited, working life.

UV Lamp The Stratasys service engineer tests its effectiveness during regular
maintenance checks, and replaces it, if necessary. You can test and adjust its
effective power with the UV Calibration Wizard (see “Testing and
Calibrating the UV Lamp” on page 56). If you need to replace the UV lamp,
follow these instructions:

1. Start the UV Lamp Replacement Wizard from the Options menu (see
figure 6-38 on page 29).

WARNING: Before continuing, make sure that the safety interlock in the
printer cover is not defeated, and that the lamp is not hot.

2. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

UY¥ Lamp Replacement Wizard

Preparation

Check that the build tray is empty.

[ The tray i clear [empty).

-/ Stratasys

Figure 6-94: “Empty tray” confirmation screen

The axes move to the “home” position.

3. On the UV-assembly cover, loosen (do not remove) the thumbscrew
indicated in the photograph below.

Figure 6-95: UV-assembly cover

4. Remove the other four (4) thumbscrews that secure the UV-assembly
cover, and remove the cover.
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5. Disconnect the UV lamp cable and the fan cable.

UV-fan connector

UV-lamp connector

Figure 6-96: Disconnecting the UV lamp assembly (top view)

6. Loosen the two side screws securing the UV lamp assembly to the
printer.

Securing
screws

Figure 6-97: UV-lamp-assembly

7. Remove the assembly, and place it on a flat surface.
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8. Loosen the screws securing the UV lamp cover and remove the cover.

Cover screws

Figure 6-98: UV-lamp-cover screws

9. Loosen the two screws securing the UV reflector.

Figure 6-99: UV-reflector screws

10. Remove the UV reflector by raising it slightly, then pulling it out of the
housing at an angle, from the bottom.

Figure 6-100: Removing the UV reflector from the UV assembly
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11.

Discard the old reflector and lamp.

requirements.

% Dispose of the used UV lamp in accordance with environmental and safety

12.
13.

14.
15.

16.
17.

DOC-34015 Rev. B

Insert the new UV lamp/reflector unit into the housing.

Make sure that the UV-lamp cable is in place, inside the housing, and
then tighten the securing screws.

Figure 6-101: Cable position when installing the UV lamp

Replace the lamp cover, and tighten the securing screws.

Replace the UV lamp assembly in the printer, making sure that the
cable fits into the slot together with the side securing screw.

Figure 6-102: UV-lamp cable after replacing the assembly

Tighten the two side securing screws.

In the wizard screen, confirm that you have replaced the lamp and that
the black strip is attached, then click Next.

Installation Check

Confirm before continuing:

[] The black strip was comectly placed in the reflectar.
[ The new LY lamp was installed.

-/ Stratasys

Figure 6-103: UV-installation confirmation screen
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Accessing
Built-in Tests

The wizard operates the lamp to test if it is installed correctly. If the
lamp does not light, the wizard prompts you to check the power
connections and to re-install the lamp.

UY¥ Lamp Replacement Wizard

./../"' - Y Wizard Completed

-/ Stratasys

Figure 6-104: Final wizard screen

Note: The UV lamp remains on until you click Done.

After replacing the UV lamp:

* Calibrate its power by running the UV Calibration Wizard (see “Testing
and Calibrating the UV Lamp” on page 6-56). Wait at least two minutes for
the UV lamp to cool before starting the UV Calibration Wizard.

* Calibrate the new UV lamp again after 100 hours of printing.
A sanity check of the software parameters is available from the Built-in

Tests interface. Because this effects the operation of the printer, you can
only open the Built-in Tests interface when the system is not printing.

To open the Built-in Tests screen, do one of the following:
* From the Options menu, select Built-In Tests.
* Press Ctrl+Alt+B.

{ File Options Help .

$ VStratasyS Go to Tray Upper Position FS ]
<l (Goto Service Position F&
Wipe F7?

Execute Purge Sequence  F4
Pattern Test F3

‘Wizards 3
Built: In Tests... Chrl4+-AlE+E

Maintenance Counters...
Collect Service Data F2

Shutdown Wizard F&

Figure 6-105: Selecting Built-In Tests from the Options menu
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Test Interface  The Built In Tests screen lists pre-configured tests.

Built In Tests

Test name Group S Emor Description
O Paramemeter 5 anity Check Parameters ?

X
@ Bun

Summarny

?

Tests Selection
Group Selection Set

[ all ] [None] ’Unknown] |--None-- v| |--None-- v|

Figure 6-106:Built In Tests screen

Status

The “S” column shows the results of the test after you run it:

"  Test successfully completed.
X Test failed.

?  Unknown results. (The test has not been run yet.)

To run the test:

After you run the test, the Save and View command buttons are added to
the Built In Tests screen.

a Feset

Figure 6-107: BIT command buttons

Test Results To save and view a report of all of the tests:

» Use the Save and View command buttons.
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Container
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Printer waste contains partially cured polymeric material, collected during
normal operation and maintenance of the printer. For safety and
environmental reasons, this material is kept in a special leak-proof,
disposable container.

The container has a capacity of 1.8 kilograms of waste material —usually
enough for several weeks of printer use. The printer software displays a
warning message when there is 1.5 kilograms of material in the container,
and stops the printing when the net weight reaches 1.8 kilograms. Above
1.5 kilograms, the software does not allow you to start a print job (or a
printing activity) until you replace the waste container. You can monitor the
weight of the waste container in the Maintenance screen of the printer
interface.

To monitor the waste weight (and other indicators) in the printer:

» In the main printer interface screen, click the display toggle to view the
printer indicators.

File Options_Help _ % |

| :‘" Stratasys

Heads(°C) Sensors
[ 45 |- 12
Maintenance | g0 ort 62 | waste(or) R D Waste weight
| Model G| | Ambient (°C) |
| Heads Liquid |

ﬁ\w Display
toggle button
_VernWh'rle_

T 2mogr
FullCure705

Tray1.objtf

Current Mode: Print Made

=

Figure 6-108: Printer interface, showing waste weight (red background indicates
operator alert)

The waste container consists of a sealed bag inside a cardboard box. You
typically dispose of the entire waste container —including the box.
Therefore, you must assemble a new box and insert a new waste bag before
you can install it in the printer.

Replacement boxes, waste bags, and sealing caps are supplied in the Objet
printer start-up kit and in the preventive-maintenance Kkit.

To prepare a new waste container:

1. Assemble the cardboard box, making sure to punch out the perforated
sections.

2. Fold a new waste bag—so it fits in the box—and insert the bag’s screw-
connector into the hole in the top of the box.

Note: Do not close the box until you connect the waste drain tube from the
printer.
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To replace the waste container:
1. Open the materials drawer.

2. Remove the fireproof cover from the waste container.

Figure 6-109: Removing the waste-container cover

Unscrew the cap connecting the waste drain tube to the container.
Carefully lift out the waste container to remove it from the printer.

5. Close the full container with the cap supplied with the new waste
container.

6. Place the new waste container in the materials drawer, and attach the
cap connected to the drain tube.
Important: Hold the waste bag with one hand while attaching
the waste tube. Otherwise, the bag will be twisted, and the
flow of waste will be restricted.

7. Close the new waste-container box.

|
Figure 6-110: Waste container with drain tube attached
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Backing-Up
and Restoring
Printer
Settings

Relnitiate
Wizard

6-70

8. Place the fireproof cover over the waste container, making sure that the
drain tube is free and not bent.

Figure 6-111: Fireproof cover installed over the waste container

Note: Operating the printer without the waste-container cover results in an
inaccurate measurement of the waste weight, which will cause waste to
overflow into the printer.

9. Close the materials drawer.

Dispose of the full waste container in accordance with environmental and
safety requirements.

The painted exterior plastic panels of Objet 3D printers have a durable
finish, offering excellent chemical resistance to common cleaning materials.
However, it is recommended that you use only a mild soap solution for
routine cleaning.

Printer modes and configuration settings are stored in files on the printer
computer. You can back up these files, and restore them, if necessary, using
desktop icons.

BackupData Restorelata

Figure 6-112: Backup and restore desktop icons

One of the wizards listed in the Options menu is Relnitiate. You normally do
not have to run this wizard. The process that this wizard controls runs
automatically, when needed, as part of the Pre-print mode (before printing
begins). Run this wizard only if a Stratasys Customer Support engineer
instructs you to do so.
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Handling Printed Models

Removing Models After Printing

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on
the printer, it is best to let the printed models cool in the printer, with the
cover closed, as long as possible.

If the printer must be used to produce additional models as soon as
possible:

1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or
spatula (supplied in the tool kit), taking care not to pry or bend the
model.

WARNING: Wear protective gloves when handling printed models
before they are washed.

3. DPlace the models on a flat surface, and cover them with a cardboard
box or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material

After printed models have cooled, the support material must be removed.
This can be done by different methods, depending on the size of the model,
how delicate it is, the amount and location of the support material, and
other factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.

Removing Excess Support Material by Hand

While wearing protective gloves, break away excess support material on
the outside of the model. For delicate models, use a toothpick, pin or small
brush after dipping the model in water.

Removing Support Material with Water Pressure

For most models, the most efficient way to remove support material is by
using a high-pressure water jet. One suitable system is the Objet Water]et
cleaning unit, shown in figure 7-1.
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Figure 7-1: Objet WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump
turns ordinary tap water into a high-pressure jet, and a wiper keeps the
window clear.

%( Use caution when cleaning delicate models with high-pressure water systems.

Removing Support Material with Caustic Soda

Soak models in a 2-percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult-to-reach areas and to give the
model a smooth, clean finish. The amount of time you soak the model in the
solution depends on how delicate it is and how much support material
needs to be removed, but it is typically between half-an-hour and several
hours. In any case, you should remove as much support material as
possible before the caustic soda treatment, and rinse the model thoroughly
(with a water jet) afterwards.

blindness. Mixing it with water generates heat that could ignite other
materials. Never pour water into a caustic soda solution. When diluting
the solution, always add caustic soda to water. Take adequate safety
precautions; always use nitrile gloves when handling caustic soda and
models soaked in it.

: WARNING: Caustic soda may cause chemical burns, scarring and
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Post-Printing Treatment for Models Printed with Objet VeroClear

Models made with Objet VeroClear have a slight yellow tint when removed
from the printer. This is especially true for models printed with a glossy
finish. The yellow tint fades naturally over time, but you can greatly
accelerate this process by using a suitable photobleaching treatment.

As arule, best clarity is achieved when parts are printed with a matte
finish, and treated as explained below.

Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.

P [

. s

Figure 7-2: lllumination chamber Figure 7-3: Desk lamps
Photo-
Bleaching
Instructions Follow these instructions for photobleaching printed models.

® The fluorescent lamps should be rated 45W, 6500K.

® When using desk lamps, place the models in a container covered with
aluminum foil. Use at least two lamps, more when treating models in a
large container.

® Arrange the models with enough space between them to allow light to
reach all sides of each model.

® Verify that the ambient temperature around the models is
approximately 40°C (104°F). Higher temperatures may cause model
distortion; lower temperatures may not produce satisfactory results.
When using desk lamps, you can achieve the required temperature by
positioning the lamps approximately 10 cm (4 in.) above the models.

® Inspect the models after six hours of treatment.

O For parts with a matte finish, this should be enough. Polish and
lacquer the parts.

O For parts with a glossy finish, continue the photobleaching
treatment for up to 18 hours more.

In Stratasys laboratories, there was a tint reduction of approximately
70% within six hours. After 24 hours, tint was reduced by
approximately 90%.

More information about this treatment is available in the application note
VeroClear RGD810 Model Material.
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Models are cured as they are printed, making them safe and stable for a

long time. However, proper storage conditions are necessary to prevent
deforming.

® Keep printed models at room temperature and in a low-humidity
environment.

® Do not expose models to direct sunlight and other heat sources.
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